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PROKITCHEN START-UP PAGE
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Select the ProKitchen icon to start the program.

Note: The ProKitchen program will automatically create a short-cut on your desktop. We recommend that you leave this short-
cut on your desktop for quicker access to the program.



CLASSIC OR RIBBON INTERFACE
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In pop-up window select ‘Classic’ or ‘Ribbon’ Interface.  

If you wish not to receive this message again click the “Don’t show this message again” box.



1.1 NEW/OPEN WINDOW
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1.1.1 To create a new design select the ‘Create a new design’ radio button.

1.1.2 Click the ‘OK’ button. 

Project: Click the ‘Create a new design’ radio button, then click the ‘OK’ button.

1.1.1

1.1.2



1.2 INITIALIZE/UNINITIALIZED CATALOGS
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1.2.1 Select a double arrow in the ‘Catalogs’ panel. ‘Show All’ or ‘Show Initialized’ options appear. By selecting ‘Show Initialized’ 
you can see only already initialized catalogs. By selection ‘Show All’ you can see all the catalogs for which you have an authorization 
from a cabinet vendor. 

1.2.2 To Initialize a catalog select a grey catalog name and press ‘Initialize’ button. In ProKitchen Standard a catalog becomes 
available in a few minutes. In ProKitchen Online it becomes available in a few seconds. 

1.2.3 To Uninitialize a catalog select a black catalog name and press ‘Uninitialize’ button.

1.2.1
1.2.2

1.2.3



1.3 CREATING A DESIGN FILE
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1.3.1 To create a design file click the ‘Browse’ button. This opens a window that allows you to select the file where your design will 
be saved.

Project: Click on the ‘Browse’ button.

1.3.1



1.4 FILE SAVING
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1.4.1 Use the drop-down menu to select the location where the design will be saved.

1.4.2 In the text box type the file name for this design. Click the ‘Save’ button.

Project: Click the ‘Browse’ button, select the file folder using the drop down menu, type in the design name and click the ‘Save’ 
button.

1.4.1

1.4.2



1.5 DESIGN WINDOW - CREATING A NEW DESIGN
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1.5.1 The file name and location of the design is now listed in the ‘Design File’ text box.

1.5.2 Click the ‘OK’ button to view the ‘Design’ window.

Project: Click the ‘OK’ button.

1.5.1

1.5.2



2.1 CREATING WALLS
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2.1.1 To use predetermined wall layouts, click the ‘Room’ buttons located on the ribbon panel.

Note: You may select ‘U-Shape Room’, ‘L-Shape Room’ or ‘Rectangle Room’.

2.1.2. To select the orientation of the walls click the corresponding button.

2.1.3 Type wall dimensions in the text boxes or use the up and down arrows and click the ‘OK’ button.

2.1.1

2.1.2

2.1.4

2.1.3

2.1.5

2.1.5



2.1 CREATING WALLS
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Note: Arrows on the left are Inches; arrows on the right are Fractions.

Project: Draw Wall ‘A’ to 156 3/8” and Wall ‘B’ to 136 5/8”. 

Select ‘Wall Height’ 98” (Please use the same orientation as shown in the example). Remove these walls by clicking the ‘Undo’ 
button.

2.1.4 To draw walls click the ‘Sketch Walls’ button, then select the area to start the wall in.

2.1.5 There are two different ways to set wall lengths. 

One: Use the text boxes in the ‘Info’ panel, type in the dimensions and/or angle then press ‘Enter’. 

Two: Click the left mouse button to draw the wall. To finish the wall and start an adjoining one click the left mouse button again. 
Left-click behind the last wall drawn or press the escape key to finish drawing walls.

Note: When using the ‘Info’ window to enter dimensions keep your mouse still; moving the mouse will draw walls manually.

Project: Draw an L-Shape wall, with the starting point in the bottom left quadrant. Left Wall - 147” and Top Wall - 147 1/2” using 
the ‘Sketch’ Walls button.

Note: Click on the ‘Zoom To Fit’ button to resize the window (if necessary).



3.1 PLACING A WINDOW
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3.1.1 To place a window click the ‘Windows’ button on the ribbon panel.

3.1.2 Open the ‘Windows’ folder to see the selection of windows by clicking the ‘Expand’ button or double-clicking the folder.

3.1.3 Click the window style to open the windows descriptions.

3.1.4 To place a window highlight it, then click the ‘Place’ button.

3.1.1

3.1.2

3.1.3

3.1.4



3.2 PLACEMENT ZONE
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3.2.1 Place the cursor in the ‘Placement Zone’ and click the left mouse button. Slide the window along the wall to the selection      
position. Left click to set the window.

3.2.2 The position of the window is indicated in the ‘Info’ window. The window position can also be typed into the text box in the 
‘Info’ window.

Note: After placing the window the ‘Windows’ window re-opens. If there are no more windows to place, close the window.

Project: Place a 30”x36” window of your choice, 51” from the left, on the top wall using the ‘Info’ window.

3.2.1

3.2.2



3.3 PLACING CABINETS USING CATALOG WINDOW
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3.3.1 Select the cabinet line from the ‘Catalog’ window drop down menu.

Tip: Close the ‘Designs’ window, in the left panel to allow additional space. This window can be reopened in the ‘View’ menu, if 
needed.

3.3.2 Select the cabinet category by clicking on the ‘Expand’ button (example Wall Cabinets).

3.3.3 Select the cabinet style by clicking on the ‘Expand’ button (example Corner Cabinets).

3.3.1

3.3.5

3.3.3

3.3.4

3.3.6

3.3.7



3.3 PLACING CABINETS USING CATALOG WINDOW
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3.3.4 Select the cabinet by clicking the cabinet type (example Diagonal). This shows all the cabinets available in the selected type.

Double-click the nomenclature/description to bring up the product window. Select the cabinet and drag & drop into the ‘Placement 
Zone’.

3.3.5 A window appears when you have started or changed catalogs in a design. Click the ‘Confirm’ button to set the cabinet. 

Note: Double-click on the picture in the info window to change it from 3D to a black and white. While in the 3D view use the right 
mouse button to rotate and the center mouse button to zoom in and out on the item.

3.3.6 To place a cabinet using the ‘Find’ button, type a cabinet nomenclature or brief description and click the ‘Find’ button. This 
brings up all items containing the information that was entered. Select and place as before.

3.3.7 The ‘Info’ window shows a picture of the selected item.

Project: Using your manufacturer`s catalog place a 24”x30” Diagonal Wall Corner (left hinge) in the corner using the Catalog meth-
od (steps 3.8 - 3.12). Place a W1230L on the right of the Diagonal Wall Corner using the Find button (steps 3.13 & 3.14).

Note: Close the ‘Cabinet’ window that appears after the cabinet is placed.



3.4 PLACING CABINETS USING THE CABINET BUTTON
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3.4.1 Click the ‘Cabinet’ button located on the left toolbar.

3.4.2 Select the catalog line to be used.

3.4.3 Select the cabinet category by clicking on the ‘Expand’ button or double-clicking the folder.

Note: Cabinets may also be found using the ‘Find’ button.

3.4.4 Select the cabinet style by clicking on the ‘Expand’ button or double-clicking the folder.

3.4.1

3.4.3

3.4.4

3.4.5

3.4.2

3.4.6

3.4.7



3.4 PLACING CABINETS USING THE CABINET BUTTON
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3.4.5 Select the cabinet by clicking on the cabinet type. This will display all the cabinets available in the selected type.

3.4.6 Double-click on the nomenclature/description to bring up the product description window.

3.4.7 Highlight the cabinet to set it into the plan and click the ‘Place’ button.

Note: When an item is in the cursor, the cursor changes to a + sign.

3.4.8 Place a cabinet by placing the cursor in the ‘Placement Zone’ and click the left mouse button.

Note: Corner cabinets need to be placed into the corner ‘Placement Zone’.

Project: Place a Base Eazy Reach Pie 36 into the corner using the ‘Cabinet’ button.



3.5 PLACING CABINETS PROJECT
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Project: Place a B12L on the right of the 36” Lasy Susan, then place a SB36 next to the B12L. Use any of the three ways to place 
these cabinets: ‘Cabinet button’, ‘Catalog’ drop-down menu or ‘Find’ tool.



3.6 PLACING APPLIANCES
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Appliances can be placed using two of the three placement functions.

3.6.1 Use the ‘Catalog’ window to select the ‘Appliance Catalog’ and select the ‘Appliance’ from the drop-down menu.

3.6.2 Use the ‘Appliance’ button to select the category, select the appliance from the drop-down menu and click the ‘Place’ button.

Project: Place a dishwasher to the right of the sink base cabinet. Place a 30” Range and a refrigerator on the ‘Left Wall’.

3.6.2

3.6.1



3.7 PLACING SINK AND FAUCET
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3.7.1 Sinks and faucets can be added in ‘Attributes Dialog’. Select cabinet where the sink and faucet should be placed, right-click 
select ‘Attributes Dialog’ inset ‘Sinks and faucets’ choose the desirable sink and faucet and it will be automatically installed into the 
cabinet.

3.7.1



3.7 PLACING SINK AND FAUCET
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3.7.2 Sinks and faucets can be placed by using the ‘Plumbing’ button.

3.7.3 Sinks and faucets can also be placed by using the catalog window.

Select the ‘Plumbing’ catalog and scroll-down to the sink then drag and place the sink as before.

Project: Place an under-mount sink and faucet in the sink base cabinet.

3.7.2

3.7.3



3.8 AUTO PLACING COUNTERTOPS
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3.8.1 To place countertops click the ‘Countertop’ button. This will automatically place a countertop on all base cabinets.

Project: Place a countertop.

3.8.1



4.1 BASIC MODIFICATIONS
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4.1.1 Right-click on the item to be modified and select that item from the drop-down menu.

4.1.2 Slide the cursor down to Attributes and click the left mouse button. This brings up the Attributes window for the selected 
item.

Note: Double-clicking on the item will also bring up the Attributes window, but only if another item is not under the selected one 
(with select manufacturers).

4.1.1

4.1.2



4.1 BASIC MODIFICATIONS
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4.1.3 Dimension changes can be made to the selected items by entering new dimensions in the text boxes, using the up and down 
arrows or clicking on the modifications tab and selecting the correct dimension modification depending on the manufacturer. Click 
the ‘OK’ button once the changes are made to save the changes.

Note: If there is a width modification available in the modification tab do not use the text boxes or arrows to make dimension 
changes. The dimensions will change, but the pricing will be incorrect.

4.1.3



4.1 BASIC MODIFICATIONS
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Project: 

Change the W1230 to 9” deep (if your manufacturer allows this modification). 

Change the width of the window to 36” using the ‘Attributes’ window.



5.1 ELEVATIONS
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There are two different ways to view an Inside Wall Elevation:

5.1.1 Right-click on the wall and select Wall, Wall # and Inside Elevation from the drop-down menus.

5.1.1



5.1 ELEVATIONS
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5.1.2 Select the wall and click the ‘Elevation’ button on the ribbon panel.

5.1.3 To view each wall elevation click on the corresponding tab.

Project: Bring up an inside elevation on the Top Wall using the drop-down menu method and the Left Wall using the Elevation but-
ton. Click the tabs to view each elevation.

Note: Each elevation can have multiple views of the same elevation.

5.1.2

5.1.3



6.1 VIEWING IN 3D
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6.1.1 To view 3D in color click the 3D button.

6.1.2 To view 3D in black and white click the ‘No Color’ radio-button.

6.1.1
6.1.2



6.1 VIEWING IN 3D
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Press and hold the left mouse button to move the 3D view up/down or left/right. 

Press and hold the center mouse button to zoom by moving the mouse front and back. 

Press and hold the right mouse button to rotate the view. 

Buttons are also provided on the top toolbar for controlling the same functions.

Project: Click the 3D button & use the three mouse buttons then close the 3D window.



6.2 CREATING 360 PANORAMA
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6.2.1 For creating a panorama view open 3D. On upper icon panel click on Create Panorama Button and this will open a dialog box 
for creating panorama. Available actions:

- Creating the name of panorama;

- Choosing rendering quality;

- Choosing position of the camera. Default position is in the center. When Move the Camera is chosen, highlighted camera can be 
dragged by the mouse;

- Select the resolution for the final image;

- ‘Default’ Button – reset settings;

6.2.1



6.2 CREATING 360 PANORAMA
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After clicking ‘OK’. Progress bar is on the screen. Creating the panorama can be discontinued by clicking ‘Cancel’.



6.2 CREATING 360 PANORAMA
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After creating automatically opens preview of newly created panorama in the default browser.



6.2 CREATING 360 PANORAMA
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Opens a table with a list of panoramas and informative dialog.



7.1 SETTING GLOBAL SPECIFICATIONS (PRICING)
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7.1.1 To set cabinet pricing and details click on the Global Specifications button. 7.1.2 Select the cabinet catalog using the Catalog 
drop-down menu. 7.1.3 To set each option highlight the <Click To Select> box. This brings up all the options available for the selected 
item. Each manufacturer will require different information. Each <Click To Select> box must be selected. 7.1.4 Set each value by dou-
ble-clicking on the selection. Information appears in the Info window once a selection highlighted. 7.1.5 Click on the Red Information 
icon for information about the selected item (Spec Book). 7.1.6 Once all Global Specifications are set the window can be closed.

Project: Set the Global Specifications (These will transfer to future designs).

Note: Global Specifications set the cabinet values, door styles and color assigned to the project. The door styles and finishes se-
lected in this section are shown on 3D screens.

7.1.1

7.1.2

7.1.3 7.1.5



7.2 VIEW MANUFACTURER SPEC BOOKS (FOR MANUFACTURER CATALOG ONLY)
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7.2.1 The Red Information icon brings up the manufacturer`s spec book page that refers to the selected item.

7.2.2 Use the drop-down menu to increase and decrease the size of the page(s).

7.2.3 Type the number you want to find in the page box.

7.2.4 Click on the icon on the upper right corner to close this window.

Project: Click the Red Information icon and navigate the Spec Book page(s), then close the window. Close the Global Specification

window.

7.2.27.2.3

7.2.4



8.1 REPORTS
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8.1.1 Select the ‘Manufacturer Report’ button to set up the information for the manufacturer.

Once the ‘OK’ button is selected the ‘Catalog Settings’ window will appear. (The information on this page will be more complete 
once the full training book is covered).

8.1.1



8.1 REPORTS
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8.1.2 The toolbar allows navigation of the Manufacturer Report such as saving, printing, paging up/down and zooming. The report 
shows all the cabinet information including door style(s), finish(es), cabinet(s), accessories, cost, shipping and customer information.

Project: Create a Manufacturer Report, navigate through it then close the window.

8.1.2



9.1 EMAILING A DESIGN
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9.1.1 To place the order via the internet or send the design to another user please use Share > Send Using E-Mail from filetab menu.

Note: When using this button the recipient(s) must have the same or newer version of the ProKitchen program.

9.1.1



9.1 EMAILING A DESIGN
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9.1.2 This window works the same as most email accounts. Enter in all email addresses, notes and attachments as necessary.

Note: Do not email the order unless you would like it to be emailed to the recipient.

9.1.2



9.2 ELECTRONIC ORDERS
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9.2.1 Select the ‘Electronic Orders’ tab at ribbon panel and click ‘EZ-Link’ button to place the order via the internet.

9.2.2 Select the appropriate manufacturer and click the ‘OK’ button.

9.2.1

9.2.2



9.2 ELECTRONIC ORDERS
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9.2.3 Enter your account number and password then click the ‘OK’ button to send the order.

Note: This option is available for select cabinet manufacturers. 

Note: Do not email this order (unless you are placing an order).

9.2.3



10.1 VIEW PANELS
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There are eight different View Panels. View Panels include: Designs, Info, Edit, Catalog, Global Specifications, Bill Of Materials,          
Elevation and Design. Each View Panel can be shown on the screen at the same time or individually.

10.1.1 To hide a view window click the “X” in the upper right corner of the View Panel. 10.1.2 To show a view window either click 
the corresponding button on the top toolbar or use the View drop-down menu. 10.1.3 To adjust a View Panel place the cursor on the 
window`s edge, when a double-headed arrow appears click and hold the left mouse button and slide the cursor (View Panel window) 
to the desired position. 10.1.4 To set a View Panel to the full screen double-click on the title bar at the top of the View Panel. To re-
duce the view to the original size double-click on the title bar again.

Project: Open all panels, expand a panel to full screen and return it back to standard size then close the Bill Of Materials (BOM), 
Global Specifications and Elevation panels.

10.1.1

10.1.2

10.1.3

10.1.4



10.2 RIBBON PANEL
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Edit tab: 

Use this toolbar to edit a design, undo/redo your actions or to change product attributes, modifications and accessories.

Draw & Place tab: 

Use this toolbar to create/edit walls on the design, to mirror items horizantally/vertically, to place different design items, to search 
for models or verify your design according to NKBA standards.

Doors & Windows tab: 

Use this toolbar to select, place and edit windows/doors in the design.

3D tab: 

Use this toolbar to access 3D window, to control view options, to access wall/floor/countertop/ceiling options and panorama 
settings.



10.2 RIBBON PANEL
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Reports tab: 

Use this toolbar to create and setup different types of reports.

Electronic Orders tab: 

Use this toolbar to export data to the EZ-Link system, XML, Spruce, Saberis and QuickBooks.

Measurement & Comments tab: 

This toolbar allows placement of dimensions on the design plan, comments and additional lines.

View & Settings tab: 

Use this toolbar to access zooming options, to setup view options, to access Plan/Elevation/BOM windows and different settings 
as well as gaining access to Image Collection.



10.2 RIBBON PANEL
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Ctops & Moldings tab: 

Use this toolbar to access Countertop/Closet Designer windows and to control countertops, backsplahes, moldings and lightings.

Catalog & Solutions tab: 

Use this toolbar to add new solutions, to update, copy, unintall or switch catalogs.

Search tab: 

This toolbar allows to search for existing designs and customers.



10.3 FAVORITE PANEL
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10.4.1 To Enable/Disable ‘Favorite’ bar please click on the button in the top right corner.

10.4.2 To Show/Hide ribbon-panel use button in the top right corner.

10.3.1

10.3.1 10.3.2



10.4 FILETAB
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10.4.1 To access filetab please click on the blue ‘File’ button in the top left corner of the ribbon panel.

10.4.1



10.4 FILETAB
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10.4.2 Filetab allows you to create, open, save, print and share your designs, export/import data, edit application settings, access 
account information and help section.



11.1 STARTING A NEW DESIGN
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Project: Start a design using a filetab.



11.2 DESIGN SETTINGS - DESIGN TAB
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11.2.1 Select the Design tab to access the design information panel. This panel contains the Contact #, Order #, Design Status, 
Processed By, Date Created, Last Modified and Notes. 

11.2.2 Use the drop-down menu to set the status of the current project.

11.2.3 The design creation date is automatically created when a design is started. The Last Modified Date will automatically up-
date when the project is changed.

11.2.4 The Note text box is used to apply notes to the current project. Text in this box will appear on the front page of the ‘Cus-
tomers Report’.

Project: Fill in all fields and dropdown menus and select the Customer tab.

11.2.1

11.2.2

11.2.3

11.2.4



11.3 DESIGN SETTINGS - CUSTOMER TAB
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11.3.1 Select the ‘Customer’ tab to access the customer information panel. 

11.3.2 Before any information can be entered a customer database needs to be created. To create a customer database click the 
‘Browse’ button. 

11.3.3 To create a new customer click on the ‘New’ button. This will brings up the ‘New Customer’ window.

11.3.1
11.3.2

11.3.8

11.3.8

11.3.3



11.3 DESIGN SETTINGS - CUSTOMER TAB
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 11.3.4 Customer information is entered into the provided text boxes. The names and/or information entered into the ‘First Name’ 
and ‘Last Name’ text boxes will show in the ‘Customer’ and ‘Manufacturer’ reports. 

11.3.5 Click the ‘Address’ button to enter the address information. 

11.3.4

11.3.5

11.3.7



11.3 DESIGN SETTINGS - CUSTOMER TAB
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11.3.6 Enter the customer`s address information in the text boxes and drop-down menus as necessary. 

11.3.7 Use the ‘Same As Mailing’/’Same As Shipping’ check boxes if the address are the same. 

11.3.8 To select an existing customer, highlight the customer line and click the ‘Select’ button or double-click the line.

Note: See previous page for details.

Project: Create a new customer and click the ‘OK’ button. Select the newly created customer and click the ‘Dealer’ tab.

11.3.6



11.4 DESIGN SETTINGS - DEALER TAB
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11.4.1 Select the ‘Dealer’ tab to access the dealer information panel.

11.4.2 All the dealer information is entered into the provided text boxes under the ‘Dealer’ tab.

11.4.3 The address information is entered in the same format as in the ‘Customer’ tab.

11.4.4 Use the ‘Clear’ button to clear all current information.

Note: Once the ‘OK’ button is clicked the information on this tab will hold in the program. There is no need to enter this information 
on every design.

Project: Fill in all the dealer information including the address then click the ‘Designer’ tab.

11.4.4

11.4.3

11.4.2

11.4.1



11.5 DESIGN SETTINGS - DESIGNER/SUPERVISOR TABS
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11.5.1 Select the ‘Designer’ tab to access the designer information panel.

11.5.2 To create a new designer or select an existing one click the ‘Browse’ button. This works in the same manner as the ‘Cus-
tomer’ tab.

11.5.3 The ‘Same as Dealer’ and ‘Same as Supervisor’ buttons are used if the information is the same.

Project: Set up a new designer using the ‘Browse’ button then click the ‘Supervisor’ tab.

11.5.3

11.5.2

11.5.1



11.5 DESIGN SETTINGS - DESIGNER/SUPERVISOR TABS
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11.5.4 The ‘Supervisor’ tab is completed the same as the ‘Designer’ tab.

Project: Create a new ‘Supervisor’ then click the ‘Construction’ tab.



11.6 DESIGN SETTINGS - CONSTRUCTION TAB
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Project: Set the construction settings:

1. Wall Thickness = 4 1/2”

2. Zone Width = 30”

3. Wall High = 108”

4. Bottom Alignment = 54”

5. Click the Moldings tab.

11.6.1 Select the Construction tab to ac-
cess the construction information panel. 

11.6.2 To set the thickness of the walls 
use the up/down arrows or type in the wall 
thickness. 

11.6.3 To ’Apply to existing walls’ - make 
a tick mark, if desired, to be applied to all ex-
isting walls.

11.6.4 To set the zone width use the up/
down arrows or type in the zone width. The 
zone width is the space in which items are 
placed. 

11.6.5 To set the wall height use the up/
down arrows or type in the wall height for 
the current project. This sets all the walls at 
the height entered. See the walls section to 
change the height of each wall. 

11.6.6 Wall cabinet heights can be de-
ter-mined by using the dropdown menu. Set 
the ‘Top Alignment‘ or the ‘Bottom Align-
ment‘.

11.6.7 Additional Weight (pallet) – Select 
the value by either using the up/down arrows 
or typing in the value. 

11.6.8 Dimension Nomenclature Orienta-
tion – We can use either default or 45 clock-
wise/ 45 counter clock-wise or 90 clock-
wise/ 90 counter clock-wise. 

11.6.9 We can select the offset from the 
hood in the field ’Auto-offset Hoods from 
Cabinets’ by using the arrows or typing into 
the field.

11.6.5

11.6.6

11.6.7

11.6.8

11.6.9

11.6.4

11.6.3

11.6.2

11.6.1



11.7 DESIGN SETTINGS - MOLDINGS TAB
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11.7.1 Select the ‘Moldings’ tab to access the molding information.

11.7.2 To set the default for ‘Light Rail Moldings’ and ‘Top Moldings’ select the appropriate check boxes then choose the cabinet 
catalog(s) and molding type(s) using the drop-down menus.

11.7.3 Similar to selecting molding, click to select a toe-kick. Once selected use the drop down list to view and select one of the 
available toe-kicks.

11.7.4 If you want to add lighting to the molding or toe-kick, use ‘Molding Lighting’ button. In the dialog box, put a check mark 
against those moldings to which you would like to add lighting. After that, select the wattage for each lighting source by using the 
horizontal scroll bar. Finally, you can specify the distance between the lightings. That distance determines the number of lighting 
sources per each molding.

11.7.4

11.7.3

11.7.2

11.7.1



11.7 DESIGN SETTINGS - MOLDINGS TAB
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Note: If stacking moldings (a subcrown with a crown) select the 1st piece of molding that is to be placed onto the top of the upper 
(and tall) cabinets in this window. Additional stacked molding will be dragged and dropped onto this 1st piece of molding selected in 
this window. This is covered in the placing molding section.

Project: Check the ‘Light Rail Molding’ check box, select the newly created catalog and choose a light rail molding. Check the ‘Top 
Molding’ check box, select the newly created catalog and choose a sub-crown molding, then Check the Toe-Kick Lighting and choose 
a toe-kick. Then click the ‘Countertops’ tab.

11.7.4



11.8 DESIGN SETTINGS - COUNTERTOP TAB
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11.8.1 Select the ‘Countertop’ tab to access the countertop information panel.

11.8.2 Use the up/down arrows or type dimensions in the text boxes to set the countertop overhangs and the thickness of the      
countertop.

11.8.3 In the same window we select the backsplash depth and height.

Project: Set the countertop overhangs and thickness (if needed), then click the ‘3D’ tab.

11.8.3

11.8.2

11.8.1



11.9 DESIGN SETTINGS - 3D TAB 
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11.9.1 Select the ‘3D’ tab to access the 3D information panel. 

11.9.2 To set the Materials, Styles and Colors for the Countertops, Walls and Floor, click the Select button adjacent the sample box. 

11.9.3 Use the category list to select the different types of materials to be used on the selected item. The selected materials show 
in the list below and can be scanned through to find the desired color, pattern and/or style. Click on the small picture of an item and 
a larger sample appears on the right. Double-click on the large sample to select. 

Note: Any material can be used on any select surface.

11.9.6
11.9.5

11.9.4

11.9.3
11.9.2

11.9.1



11.9 DESIGN SETTINGS - 3D TAB 
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11.9.4 Use the provided text box to type in a brief description of material, style, color or pattern of the item that is needed. 

Example: Type in ‘Floral’ and it will show all the floral patterns found in the program. 

11.9.5 Use the ‘Add To Favorites’ button to add the current selection to the favorites section above. If the desired selection is in the 
favorites section double-click on that item to make the selection for the selected item. Use the delete button to delete the selected 
item from the favorites menu. Use the delete all to delete all the items from the favorites list.

11.9.6 Once the selection is made click the ‘OK’ button to secure the selection. These selections will be shown in the 3D view(s).

Note: Follow the same steps for walls, floor, countertops and ceiling.

Project: Set the colors, styles and/or patterns for the countertops, walls, floor and ceiling, then click the ‘Units’ tab.



11.10 DESIGN SETTINGS - UNITS TAB
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11.10.1 Select the ‘Units’ tab to access the units information panel.

11.10.2 To select the dimension style click on the corresponding radio button.

Example: Metric is 914mm; Imperial Inches is 36”; Imperial Feet-Inches is 3’ - 0”

Project: Select the Imperial Inches radio-button and click the ‘OK’ button. This finishes the Design Settings.

11.10.2

11.10.1



12.1 GENERAL TAB
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To set ‘Default Settings’ select ‘Settings’ from the menu bar and choose ‘Default Settings’.

The ‘General’ tab is used to set the file path by using the browse button and selecting the default folder where all designs will be 
saved to. This window also allows the user to enable and disable the Auto-save/Auto-backup options as well as set their time inter-
vals. The Direct3D and OpenGL options are used for various graphics cards. If you have problems with the 3D option please change 
this setting to the other and try the 3D option again. If this doesn’t remedy the problem call Customer Support.

The ‘Info Panel’ will set the image type to appear in the info panel in various windows. Image shows a black and white line drawing, 
while the 3D shows a fully rotational view of the actual selected item.

Note: Setting the default to Image will increase the overall performance and speed of the program.



12.2 FONTS TAB
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In Font Tab, you can chose usable Front Size and Icon Size, choose - 100%, 125%, 150% or 200%. After changes system will ask to 
restart ProKitchen.



12.3 CONSTRUCTION TAB
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12.3.1 Select the ‘Construction tab’ to access the construction information panel. 12.3.2 To set the thickness of the walls use 
the up/down arrows or type in the wall thickness. 12.3.3 Apply to existing walls - To “Apply to existing walls” - make a tick mark, if 
desired, to be applied to all existing walls. 12.3.4 To set the zone width use the up/down arrows or type in the zone width. The zone 
width is the space in which items are placed. 12.3.5 To set the wall height use the up/down arrows or type in the wall height for the 
current project. This sets all the walls at the height entered. See the walls section to change the height of each wall. 12.3.6 Wall cab-
inet heights can be determined by using the dropdown menu. Set the ‘Top Alignment’ or the ‘Bottom Alignment’. 12.3.7 Additional 
Weight(pallet), To enter additional weight use the up and down arrows or type in the text box. 12.3.8 Dimension Nomenclature Orien-
tation - exist an opportunity to select default, 45 clock-wise/ 45 counter clock-wise or 90 clock-wise/ 90 counter clock-wise. 12.3.9 
Select desirable indent from cabinet to hood in Auto-offset Hoods from Cabinets with the help of up and down arrows.

12.3.6

12.3.5

12.3.4
12.3.3

12.3.2

12.3.1



12.4 COUNTERTOP TAB
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12.4.1 Select the ‘Countertop’ tab to access the countertop information panel.

12.4.2 Use the up/down arrows or type dimensions in the text boxes to set the countertop overhangs and the thickness.

12.4.3 In the same window choose the depth and height ‘Backsplash’.

12.4.3

12.4.2

12.4.1



12.5 MOULDING TABS
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12.15.1 Select the ‘Mouldings’ tab to access the moulding information.

12.15.2 To set the default for ‘Light Rail Mouldings’ and ‘Top Mouldings’ select the appropriate check boxes then choose the cab-
inet catalog(s) and moulding type(s) using the drop-down menus.

12.15.3 As well as molding, select Toe-Kick. Choose the catalog from which you want to apply the Toe-Kick,  use the up/down 
arrows to select the  available Toe-Kicks in this catalog.

12.15.4 If molding or Toe-Kick should be lighted, click the Molding Lightning button. In the pop-up window select what kind of 
molding (Light, Top or Toe-Kick) should be highlighted and make a tick near the title. Next, select the lighting power by moving the 
slider, and use the up-down to select the distance between the light sources.

12.5.4

12.5.3

12.5.2

12.5.1



12.6 UNITS TABS
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12.6.1 Select the ‘Units’ tab to access the units information panel.

12.6.2 To select the dimension style click on the corresponding radio button.

12.6.2

12.6.1



12.7 3D TABS
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12.7.1 Select the ‘3D’ tab to access the 3D information panel. 12.7.2 To set the Materials, Styles and Colors for the                                                
Countertops, Walls and Floor, click the Select button adjacent to the sample box. 12.7.3 Use the category list to select the  different 
types of materials to be used on the selected item. The selected materials show in the list and can be scanned through to find the 
desired color, pattern and/or style. Click on the small picture of an item and a larger sample appears on the right. Double-click on 
the large sample to select. Note: Any material can be used on any selected surface. 12.7.4 Use the provided text box to type in a 
brief description of material, style, color or pattern of the item that is needed. Example: Type in ‘Floral’ and it will show all the floral 
patterns found in the program. 12.7.5 Use the ‘Add To Favorites’ button to add the current selection to the favorites section above.                         
If the desired selection is in the favorites section double-click on that item to make the selection for the selected item. Use the ‘Delete’ 
button to delete the selected item from the favorites menu. Use the delete all to delete all the items from the favorites list. 12.7.6 Once 
the selection is made click the ‘Add’ button to secure the selection. These selections will be shown in the 3D view(s).

12.7.6

12.7.5

12.7.4

12.7.3

12.7.2

12.7.1



12.8 CUSTOM CATALOG SETTINGS
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The ‘Catalog Settings’ tab is used for the Custom catalog only. This is used to set all custom cabinets heights and depths and will 
not affect the manufacturers catalogs.

12.8.1 In this field are the settings for the Custom catalog. The depth and height for Base, Wall, Vanity, Desk Base Cabinets can be 
specified with the help of arrows up/down.

12.8.1



12.9 CUSTOMER REPORT
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12.9.1 In Customer report select catalog and enter required up charge or discount then select the percentage or currency.



12.10 EMAIL SETTINGS
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12.10.1 In this field, we can send by email or on ProKitchen server report and attach it to the design in the desired format by      
checing the check box next to your desired format.



12.11 SAVE ALL DISPLAY SETTINGS
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12.11.1 The ribbon panel View & Settings > Display Settings.

12.11.2 In this field you can return all original ProKitchen settings by clicking ‘Default Settings’ and then ‘OK’ button.

12.11.3 If you want to save settings - click ‘Save Settings’ where you can create a folder where you can save your settings.

12.11.4 To upload your previous settings click ‘Load Settings’. Choose your settings file and click ‘Open’.

12.11.2

12.11.3

12.11.1

12.11.4



12.12 CATALOG SETTING
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12.12.1 Catalog can be copied. Go to the required directory - click the button ‘Copy Catalog’. A window appears to write the name 
of the new catalog. Click ‘OK’ - the new catalog appears in the catalog list on the left panel.

12.12.1



12.13 IMAGE COLLECTION
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12.13.1 View & Settings > Image Collection. In this window you can add the necessary image. It can be a background for windows 
and doors, flooring, drawing on the wall etc. 12.13.2 To add an image from your computer create a folder. Click with your mouse 
on the category where you want to create a folder and click ‘Add Folder’. Folder appears with the name ‘New Folder’. Rename it by      
double-clicking. Delete by clicking ‘Remove’. To rename a folder or image click ‘Edit’ on the bottom panel. 

12.13.3 Click on the created folder and click ‘Add Image’. A window opens where you can choose the location to save your selec-
tion. click ‘Select’.

12.13.4 Added picture can be edited by clicking ‘Edit’ under the picture. In the new window you can specify the correct size, also, 
the picture can be moved or mirrored. When all parameters are entered select ‘Apply’ > ‘OK’. Your added picture will appear in 3D - 
‘User Collection’.

12.13.2

12.13.4

12.13.3

12.13.1



13.1 DISPLAY SETTINGS - LAYERS TAB
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13.1.1 You can select which components to display on the plan and which to hide.

13.1.2 Clicking on the right radio buttons you can select the font, color and line, which will separate a particular element.

Project: Change View 1 tab to say ‘Complete Design’, change View 2 tab to say ‘Wall Cabinets’, change the settings in View 2 tab 
to show only wall cabinets, change the wall cabinets color to red and make the outside line thicker and change the Display Label to 
show cabinets with the nomenclatures and dimensions.

13.1.2

13.1.1



13.2 DISPLAY SETTINGS - MEASUREMENT TAB
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13.2.1 The ‘Measurement’ tab is used to set specific measurements within the window.

13.2.2 To toggle dimensions on or off check the box next to each description.

13.2.1 ‘Appliances’ and ‘Room Elements’ (windows and doors) can be dimensioned from the center or from each side.

13.2.3

13.2.2

13.2.1



13.3 DISPLAY SETTINGS - SELECTION AND GRID TAB

81PAGEPROKITCHEN TRAINING MANUAL

13.3.1 The ‘Grid’ tab is used to set the grid’s line color, background color and size.

13.3.2 Spacing is used to set the grid spacing. Use either the up and down arrows or type the dimension in the text boxes.

13.3.3 The line color and background color work the same as previously shown.

13.3.4 The ‘Default’ button sets the current window back to the original colors and settings.

Project: Change the background and line colors on the new ‘Wall Cabinet’ tab.

13.3.4

13.3.3

13.3.2

13.3.1



13.4 DISPLAY SETTINGS - SAVE/LOAD TAB
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13.4.1 The ‘Save/Load’ tab is used to save current display settings and to load previously saved settings.

13.4.2 The ‘Save Settings’ button is used to save the current display settings. The ‘Save Settings’ window is where the newly cre-
ated display settings is saved. Create this display settings name in the text box and click the ‘Save’ button.

13.4.3 The ‘Load Settings’ button is used to load previously created display settings. To load the display settings highlight the 
setting name and click the ‘Open’ button or double-click on the name. This will load the settings into the current design window(s).

13.4.4 The default button sets the current plan back to the program defaults.

Project: Save the current settings as a file.

13.4.4
13.4.3

13.4.2

13.4.1



14.1 SETTING GLOBAL SPECIFICATIONS
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14.1.1 To set cabinet pricing and details click on the ‘Global Options’ button. 14.1.2 Select the cabinet catalog using the Catalog 
drop-down menu. 14.1.3 To set each option highlight the <Click To Select> box. This brings up all the options available for the se-
lected item. Each manufacturer will require different information. Each <Click To Select> box must be selected. 14.1.4 Set each value 
by double-clicking on the selection. Information appears in the Info window once a selection highlighted. 14.1.5 Click on the icon for 
information about the selected item (Spec Book). 14.1.6 Once all Global Specifications are set the window can be closed.

Project: Set the Global Specifications (These will transfer to future designs).

Note: Global Specifications set the cabinet values, door styles and color assigned to the project. The door styles and finishes se-
lected in this section are shown on 3D screens.

14.1.5

14.1.4
14.1.3

14.1.2

14.1.1



15.1 ROTATING WALLS
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Project: Sketch an L-Shape wall as shown above (Left Wall is 165 1/2’”and Top Wall is 150”).

15.1.1 To rotate a wall right-click on the wall, select the Wall sub-menu and then select Rotate. 15.1.2 To select the pivot point, 
click on the end of the wall to be pivoted. 15.1.3 To pivot the wall move the cursor to the desired angle and left-click to set the wall.

Note: The angle is shown in the Info window.

15.1.4 After setting the pivot point, the angle can be set using the text box in the Info window. 15.1.5 To turn the wall without using 
the menu, you can pulling on the the green arrow, select the desired direction.

Project: Rotate the Top Wall to a 56’ degree angle by either rotating the wall with the mouse or using the Info text box. Use the Undo 
button to reset the wall to the original angle.

15.1.1

15.1.2

15.1.5



15.2 MOVE WALLS
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15.2.1 To move a wall right-click on the wall, select the Wall sub-menu, select the wall then select Move. 15.2.2 Click on an adja-
cent wall to move the selected wall up or down changing the length of the adjacent wall. 

Note: This will change the length of the adjacent wall(s). Click the selected wall to move the wall left or right.

Note: This will change the angle of all attached wall(s).

15.2.3 Moving the wall without using the menu, you can simply pulling on the green arrow by arrow direction you want.

Project: Move the Top Wall up and down then click to set. Then move the top wall left and right then click to set. Use the Undo 
button to reset the wall to original position.

15.2.2 15.2.3

15.2.1



15.3 RESIZING WALLS
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15.3.1 To resize a wall right-click on the wall, select the Wall sub-menu, select the wall and select Resize.

15.3.2 Click the cursor on the end of the wall (on the blue dots).

15.3.3 Slide the cursor to the desired wall length and left-click to set the wall.

15.3.4 By clicking on the green arrow in the direction you want, you can just change the size of the wall, without using the menu.

Note: The wall dimension is shown above the wall and in the Info box.

Project: Resize the Top Wall to 76 13/16”. Use the Undo button to reset the wall to the original size.

15.3.4

15.3.2

15.3.1



15.4 EXTRUDING WALLS
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Extruding a wall can be used to create duct spaces, boxed windows, etc.

15.4.1 To extrude a wall right-click on the wall, select the Wall submenu and then select Extrude. 

15.4.2 A small box will appear on the wall. This box is the starting point for the extrusion. Slide this box to the starting point of the 
extrusion and left-click to start extrusion.

Note: Dimensions are located above the wall and in the Info text boxes.

15.4.2

15.4.1



15.4 EXTRUDING WALLS
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15.4.3 Slide the cursor to the desired extrusion length, width and/or depth.

Note: The extrusion can be placed on the inside or outside of the wall. Zoom into the extrusion location to set more precise di-
mensions or use the text box.

Project: Place an extrusion to the Top Wall. Use the Undo button to reset the wall to the original size.



15.5 ADDING WALLS
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15.5.1 To add a wall right-click on the wall, select the Wall sub-menu and then select Add Wall.

15.5.2 A small box will appear on the wall. This box is the starting point for a wall to be added. Left-click to start the wall.

Note: Dimensions are located above the wall and in the Info text boxes.

15.5.3 Slide the cursor to the desired length for the added wall, then left-click to set the wall.

15.5.4 To add a new wall to the outside of existing one, left-click on the outside of the wall and follow the same steps.

Project: Add new walls to the inside and outside of the Top Wall. Delete the added walls by left clicking the walls and pressing the 
delete key.

15.5.4

15.5.3
15.5.2

15.5.1



15.6 ADDING CONSTRUCTION WALLS
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15.6.1 A construction wall is used for adding peninsulas and islands to a design. Construction walls are added in the same manner 
as adding walls.

15.6.1



15.7 CONTINUING WALLS
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15.7.1 To continue a wall right-click on the wall, select the Wall submenu and then select Continue Wall.

15.7.2 (a) A new wall will appear on the end of the selected wall. (b) The wall length can be determined by using the Info text box or 
by sliding the cursor to the desired length and left-clicking. (c) Enter the wall dimension and/or angle and hit the Enter key. (d) Right 
click to locate the continued wall. Right-click again to set the angle and change the length. (e) Left click to set the wall length and 
continue with the next wall. To end the continued wall hit the Escape key or click the cursor behind the wall.

Note: Dimensions are located along the wall and in the Info text box.

Project: Add a 48” wall at 135 degrees of the 150” wall then add a 72” wall at 135 degrees of the new 48” wall.

15.7.2

15.7.2

15.7.2

15.7.1



15.8 WALL ATTRIBUTES

92 PAGE PROKITCHEN TRAINING MANUAL

Wall Attributes changes the wall settings.

15.8.1 To change the attributes of a wall, right-click on the wall, select the Wall sub-menu then select Attributes.

15.8.2 The radio buttons change the selected wall to a solid wall or a construction line.

15.8.3 The check boxes add and/or delete a placement zone to the selected wall.

15.8.4 The up/down arrows and text boxes are to set the wall thickness, length and/or heights.

Project: Change the Right Wall’s (72” long wall) height to 40 1/2” and place an inside and outside placement zone.

15.8.4

15.8.1

15.8.3

15.8.2



15.9 WALL ATTRIBUTES - SHOWN IN 3D
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15.9.1 The first view shows the back of the 40 1/2” height wall, but not the angled wall. When a placement zone is placed on the 
inside and outside of a wall, both sides of the wall will show in the 3D view. As the 3D view is rotated walls with only an inside place-
ment zone will disappear when viewed from the back and then reappear when viewed from the front. In the example below the 40 1/2” 
wall doesn’t disappear because it has both an inside and outside zone. 15.9.2 Click the Texture tab. You can change the color of the 
walls. If you select default then the wall will be standard color or as all others. To select a single texture to the wall, select Special and 
click select. Opens a list from which you can choose the desired texture for this wall.

Project: Click the ‘3D’ button, rotate the 3D view to see how walls disappear and reappear and then close the 3D view. Delete the 
Angled Wall and the Right Wall from the design plan view.



15.10 ADDING AN ISLAND
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15.10.1 To add an island click on the ‘Construction Line’ button, place the cursor where the island is to start and left-click to start 
the Construction Line. The length of the island is set in the same way as setting a new wall.

15.10.2 To change the attributes of the island right-click on the construction line, select the construction line and select attributes. 
This brings up the ‘Construction Line Attributes’ window.

15.10.3 Click the radio buttons to change a wall type. Check the ‘Wall Zone’ check boxes to place placement zones on the inside 
and/or outside of a wall. Use the text boxes or the up/down arrows to change the thickness and/or height of the selected wall.

Project: Draw an island 72” long, 0” thick with inside and outside construction zones as shown.

15.10.3

15.10.2

15.10.1



15.11 MOVING THE ISLAND
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15.11.1 To determine the distance between the island and the wall click the ‘Point To Line’ button on the left toolbar. Left-click on 
the end of the construction line (a green line will appear), then left-click on the inside of the wall. This will show the distance from the 
end of the island to the wall. 15.11.2 To find the dimensions of the island, to the parallel wall, left-click on the ‘Line To Line’ button 
from the left toolbar. Click on the construction line (again the green line will appear), then left click on the inside of the parallel wall. 
This will show the distance from the construction line to the parallel wall. 15.11.3 To move the island section right-click on the Island 
Construction Line, select Wall Group and select Move. This allows the island section to be moved in all directions. Once the section 
is in the desired location, left-click to set it into place.

Project: Set the island 66” from the Top Wall and 96” from the Left Wall using the dimension lines.

Note: You can set the dimensions within 1/16” to 1/8” of the actual distances.

15.11.3

15.11.2



15.12 REFRESHER PROJECT
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Project:

1. Change the Left Wall from 165 1/2” to 146 3/4” and the Top Wall from 150” to 178 3/8”.

2. Continue a 27 3/8” return wall to the right end of the Top Wall. Add an outside placement zone to this wall.

3. Move the island section to be about 102” from the Left Wall and 72” from the Top Wall.

4. Change the customer’s shipping address and email address.

5. Turn on the appliance dimensions. The screen should look like the screenshot above.

Note: Once all the walls are placed the kitchen is ready to be completed.



15.13 WALL GROUPS
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15.13.1 To add wall to the group, click menu Wall > Add to group. Then choose from which wall to create a group by clicking on it 
with the mouse. Having created a group you can move, drag and rotate them together.

15.13.1



15.14 REMOVE FROM GROUP
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15.14.1 In order to remove the wall from the group click menu Wall > Remove from Group.

15.14.1



15.15 FREEFORM WALL OPENINGS
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15.15.1 We can create a cutout in the wall or an arch shape and size desired. To do this, in the left pane, select the directory in 
Architectural Elements list. Choosing Wall Opening - FWO.

15.15.2 Transfer to the wall where the hole should be.

15.15.3

15.15.2
15.15.1

15.15.1



15.15 FREEFORM WALL OPENINGS
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15.15.3 Edit it by using the menu Elevation, right-click and choose Edit. To save the changes click on the white arrow on the top 
panel.

15.15.3



15.16 DOOR/WINDOW FRAME
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15.16.1 To create an aperture in the wall you can also use ready-made arches or rectangular cutouts in the ‘Architectural Ele-
ments’ in ‘Door/Window frame’.

15.16.1



15.17 MIRROR
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15.17.1 You can mirror wall or group of walls by clicking on the ribbon panel ‘Draw & Place’ and then select Mirror Vertically or 
Horizontally.

15.17.1



15.18 WALL ZONES & ON/OFF
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15.18.1 Elevation wall may be on the outside, inside or both sides. Right click on the wall - use the dialog box and in Wall Zone fields 
put a tick in the front of the Inside Zone or Outside Zone (or both). Click ‘’OK’

15.18.1
15.18.1



15.18 WALL ZONES & ON/OFF
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15.18.2 Click on the wall with right mouse button and using the dialog box select which side should be displayed - Inside Elevation 
or Outside Elevation.

15.18.2



15.19 INVISIBLE WALL ZONES & PANELS
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15.19.1 In 3D we have an ability to hide the wall and the panel if they interfere with the design view or for rendering.

15.19.1



15.20 USER SHAPES
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15.20.1 User Shape is used in design when you need to put another relief pattern on the part of wall or the floor, not the same as 
on a common wall. For example part of the floor is wood or part of the floor is tiled. In order to apply User Shape - in the left panel, 
select the catalog Architectural elements, choose the folder User Shapes. Choose Wall or Floor User Shapes and pull it to plan.

15.20.2 Clicking on the plan with right mouse button on User Shape appears an Attribute Dialog box. It gives you an opportunity 
to move the User Shapes, copy, rotate, lift or lower, edit or delete.

15.20.3 There are two ways to edit User Shape. Clicking edit - appears red corners, pulling them will stretch the User Shape to the 
size you want, clicking on the right mouse button, will appear a dialog where you can add or move points, rounded or cut corners.

15.20.3

15.20.2

15.20.1

15.20.1



15.20 USER SHAPES
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15.20.4 Edit User Shape is possible by choosing Attributes and right-clicking on the User Shape. A window appears, in the tab 
General - set the desired size and in Texture tab - select the color or texture for the User Shape. Put a tick As Countertop if you want 
User Shape to receive the Countertop color that is already defined in the catalog. If you want it to be wood - then put a check - Select 
wood , further down press the Select and choose desired color from the list.

15.20.5 If you want the User Shape to have a  different color or tile, choose Select Non-Wood, it opens a list with possible textures 
that you can pick from.

15.20.5

15.20.4

15.20.4



16.1 PLACING A WINDOW
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16.1.1 Use the ‘Windows’ button to bring up the selection of windows. 16.1.2 To see the available window styles double-click on 
the item category or click the ‘Expand’ button to open the drop-down menu. 16.1.3 To see the available window sizes left-click the 
windows style description. 16.1.4 In the list, scroll with the mouse to choose a window –  then will appear a field with the size of this 
window. Also you can see the sizes by right-clicking on the window you need.

16.1.5 To place a window highlight the item and click the ‘Place’ button. 16.1.6 Place the cursor in the Placement Zone and click 
the left mouse button. Drag the window to the desired location and left-click to set the window. The Info text box can be used to place 
the window from the left, center or right. Once the dimension is typed in the text box, press the Enter key to set the window.

Note: All windows are set at 30” wide.

16.1.2

16.1.1

16.1.4

16.1.5



16.1 PLACING A WINDOW
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16.1.7 Right-click on the window to be resized and select the ‘Window’ from the drop-down menu. Choose the ‘Resize’ option from 
the drop-down menu to change the window width from the right side.

Note: The window can be moved by clicking on the window (turning the outline red) and typing the placement in the edit boxes. 
The last dimension entered is where the window will be placed.

16.1.7



16.2 WINDOW ATTRIBUTES
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16.2.1 Choose attributes from the dropdown menu to change the width of the window from the center. The ‘Attributes’ window is 
also used to change the window height.

16.2.1



16.3 GENERAL
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In a new tab choose:

16.3.1 Background which will be through the widow, for this click ‘Select window View’. Opens a folder with the available back-
grounds, choose the most practical for you and click ‘Select’. You can upload any image from your computer by selecting this pc  in 
the left panel.

16.3.2 In the general tab, put down the window size, moving up and down arrows.



16.3 GENERAL
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16.3.3 You can put down the size of each section, if they are in the window. For this, right click the mouse to the desired section 
and in the ‘Section width/Section height’ specify the size.

16.3.3

16.3.3



16.3 GENERAL
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16.3.4 You can select the type and shape of the window on the bottom panel. Moving the arrow to the right - left you will see the 
available types of window, Clicking on one of them - you will see it in 3D view. 

16.3.5 If you want to add the light of the window, click ‘Add Sun Lighting’.

16.3.5

16.3.4



16.4 CONSTRUCTION

114 PAGE PROKITCHEN TRAINING MANUAL

16.4.1 In the ‘Construction’ tab select ‘Installation’. You can select ‘Jambs and Casing’ or ‘Drywall Returns’. In the same tab you 
can select a profile. Click on your profile and there will appear 3 variants - put the mouse on the right and click ‘OK’.

16.4.2 Moving the arrow right or left , at the bottom of the panel, select the desired design. Clicking on top of it and you will see it 
displayed in 3D.

16.4.1
16.4.1

16.4.2

16.4.2



16.5 SPECIAL SHAPES
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16.5.1 At the bottom of the panel moving the arrow to the right or left , select the desired design. Clicking on top of it you will see 
it displayed in 3D.

16.5.1

16.5.1



16.5 SPECIAL SHAPES
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16.5.2 At the Special Shapes tab we have the ability to change the shape of the window. Rectangular, Round Glass, Round Top, Full 
Arch Head, Elliptical. It is possible to change the height of the arch in the ‘Arch Height’ by moving the up and down arrows.

16.5.2



16.6 GRILLE PATTERNS
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16.6.1 In the Grille Patterns we can add and choose one of the types of rails on the windows, specify the desired number of rails 
on verticals and horizontals. We can also select the desired profile.

16.6.1



16.7 WINDOW GLAZING
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16.7.1 In the Window tab select glazing options(not glazed, single glazed, double glazed) and Grille Installation (no grille, inside 
only, inside and outside, between the glass).

If you choose single glazed or double glazed – in the bottom you can select clear, matte, white or smoked.

16.7.1



16.8 WINDOW INTERIOR
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16.8.1 In this field you choose whether you want stool & apron and casing on your window. Put a tick in the box opposite Install 
stool & apron if you want it to be on the window. Right clicking on the casing you choose the desired shape more over it is necessary 
to choose the form of Stool.

16.8.2 Put a tick in Install Casing box if you want it to be on the window and then in the field you can put a width with the help of 
arrows. In the right field click Casing then select its form.

16.8.3 The color of the window you can choose at the bottom. Moving the arrows right or left you will see available colors. Clicking 
on one of them will allow you to see the color in 3D.

16.8.2
16.8.1

16.8.3



16.9 WINDOW EXTERIOR
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16.9.1 In this field you can select the Brickmould and window color to the outside. To install the Brickmould to the window - set a 
tick. Select Brickmould field and choose the style of it. At the bottom select the desired color.

16.9.1
16.9.1

16.9.1



16.10 HARDWARE

121PAGEPROKITCHEN TRAINING MANUAL

16.10.1 You can install or remove the hardware to the window. You just need to place or remove a tick mark in Install Hardware field.

16.10.2 At the bottom you can choose the color of the hardware. Clicking on the  hardware you want you will immediately see how 
that  hardware looks in 3D.

16.10.2

16.10.1

16.10.2

16.10.1



16.11 BLINDS
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16.11.1 Also, you can add window blinds(only in rectangular but not in rounded).You can select color, width, slightly open or close 
it. To installl it, go in the Blinds tab and put a check in front of install Blinds. 

16.11.2 In the Slat field choose the thickness of blinds. Immediately you can see how it is displayed in 3D.

16.11.3 Below Tilt field with the help of slider you can choose how opened or closed the blinds will be. We can raise or lower the 
blinds with the slider bar.

16.11.4 You can choose the color of blinds by moving the arrow right or left.

16.11.4

16.11.3

16.11.2
16.11.1

16.11.1



16.12 SAVE TO MY WINDOWS
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16.12.1 Created window can be saved by clicking Save to my Windows.

16.12.2 Saved window will be at the bottom of the list in My Windows folder.

16.12.2

16.12.1



17.1 PLACING A DOOR
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17.1.1 Use the ‘Doors’ button to bring up the selection of doors.

17.1.2 To see the available door styles double-click on the item category or click the ‘Expand’ button to open the drop-down menu.

17.1.3 To see the available doors sizes left-click the door style description.

17.1.4 Scroll the mouse to a door in your list and on the right side will appear a field with the size of this door. Also you can see the 
sizes of door by clicking the right mouse button.

17.1.5 To place a door highlight the item and click the ‘Place’ button.

17.1.3

17.1.2

17.1.1

17.1.4

17.1.5



17.1 PLACING A DOOR
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17.1.6 Place the cursor in the ‘Placement Zone’ and click the left mouse button. Drag the door to the desired location and left-click 
to set the door. The ‘Info’ text box can be used to place the door from the left, center or right. Once the dimension is typed in the text 
box, press the ‘Enter’ key to set the door.

17.1.6



17.2 DOOR ATTRIBUTES
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17.2.1 Click the right mouse button on the door and select the ‘Attributes’. Opens a window in which all door options are visible.

17.2.1



17.3 GENERAL
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17.3.1 In general in the Plan Notation we can write the name we want to see in the map on the plan. Then set the door size-width, 
height.

17.3.2 In the section width and section height we can set the size of each section of the door, pointing at it with the mouse in the 
upper left corner of the window.

17.3.3 You can set the size of the rails on the right.

17.3.4 Click Set View button (for glass doors) and choose a backgrounds for the doors (Similar to window).

17.3.5 At the bottom you can select type of door (layout) by moving the arrow right or left.

17.3.3

17.3.4
17.3.1

17.3.5

17.3.2



17.4 CONSTRUCTION
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17.4.1 In ‘Setup’ choose to install door frame or not.

17.4.2 In the ‘Reverse’ field we can change the door opening by marking a tick. f there are several doors you should point to which 
one must change (not available for all design).

17.4.3 Below we can choose the design of the door. Depending on the design there are possible configurations that can be edited.

Opening - with the help of the slider this sets the door opening (For the standard design only);

Section - select the number of sections (Folding);

17.4.2
17.4.1

17.4.3



17.5 TYPE
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17.5.1 In this field we can select the style of the door. Depending on the style there are different configurations.

For Panel Doors you can change the width and height of the Divider Rails. In each section you can set the number of columns and 
rows. You can select Groove Panel by marking a tick in the appropriate window. You can select the Framing, Edge and Pattern by 
clicking on them on the right then it will open a window with choices.

17.5.1



17.5 TYPE
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17.5.2 Choosing a design ‘French’ – section or door becomes glass. You can change ‘Shape’, ‘Options’, ‘View’, ‘Installation’, ‘Pat-
tern’. We can set the desired number of ‘Columns’ and ‘Rows’ by moving the up and down arrows. You can select ‘Grille’ and ‘Glazing 
Profile’.

17.5.2



17.5 TYPE
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17.5.3 ‘Louvered Door’ – you can change the width and the height ‘Divider Rails’. In sections you can change the number of ‘Col-
umns’ and ‘Rows’. You can choose the ‘Slat Style’. Individual sections can be closed with the panel by marking a tick in the ‘Standard 
Panel’. Just select ‘Slat Profile’, ‘Framing’, ‘Edge’.

17.5.4 Having chosen a ‘Type Special’ the door becomes flat.

17.5.4

17.5.3



17.6 DOOR INTERIOR
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17.6.1 In Door Interior choose Jamb Material Extends - Interior or Exterior.

17.6.2 Install Casing - set by default if you want to delete it just remove the tick. You can select the type of casing by pressing the 
right side of the picture. In the Casing field you can set the width by moving the up and down arrows.

17.6.2

17.6.1



17.6 DOOR INTERIOR
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17.6.3 Below you can choose the color for the inside of the door and door frame. By clicking on the desired color in the upper win-
dow you will see how it looks in 3D.

17.6.3

17.6.3



17.7 DOOR EXTERIOR
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17.7.1 In Door Interior choose Jamb Material Extends - Interior or Exterior.

17.7.2 Install Brickmold - set by default if you want to delete it just remove the tick. You can select the type of brickmould by press-
ing the right side of the picture. In the Brickmold field you can set the width by moving the up and down arrows.

17.7.2

17.7.1



17.7 DOOR EXTERIOR
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17.7.3 Below you can choose the color for the inside door and door frame. By clicking on the desired color in the upper window 
we will see how it looks in 3D.

17.7.3



17.8 HARDWARE

136 PAGE PROKITCHEN TRAINING MANUAL

17.8.1 In Hardware field select the hardware for the doors. To install the door handles mark a tick in the Install Hardware field. 
Above this field is a field with a color choice of hardware Finish: Brass, Black or Nickel. Moving the left and right arrows you can select 
the desired hardware. After choosing the color and type of handle you can immediately see the changes in 3D.

17.8.1



17.9 SAVE TO MY DOORS
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17.9.1 Door can be saved and applied in this or in a different design. To do this click Save To My Doors. The window closes.

17.9.1



17.9 SAVE TO MY DOORS

138 PAGE PROKITCHEN TRAINING MANUAL

17.9.2 The saved door would be in the list in My Doors folder.

17.9.2



18.1 CABINET POP-UP MENU
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Project: Right-click on the base 18 right and select the B18R in the drop-down menu. This shows the different actions that can 
be done to the selected item. 

Drag - This allows an item to be dragged along the wall or construction line.

Move - This allows the movement of an item from one location to another. Example: Moving a cabinet from the sink wall to the 
island.

Rotate - This allows an item to be rotated 360 degrees. The angle of the cabinet can be set using the Info text box.

45° Clockwise, 45° Counterclockwise - rotates the cabinets by 45 degrees clockwise or counterclockwise.



18.1 CABINET POP-UP MENU
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In/Out - This allows an item to be moved in and out from the wall. The distance from the wall can be set using the Info text box.

Up/Down - This allows the movement of a cabinet to be moved up and down along the same vertical alignment. The distance from 
the floor and/or the ceiling can be set using the Info text box.

Center - This allows the centering of an item under, above or onto another item. Example: This function can be used to center a 
range hood directly above a range or centering a sink into a sink base, etc.

Position - This allows an item to be positioned a specific distance away from another item.

Fit - This option is not available for all manufacturers. This allows an item to be fit into a space that is smaller in width than the 
selected item. Custom manufacturers that allow width modifications will resize and price automatically.

Snap - This allows an item to be placed tightly with an adjacent item. Example: When placing two windows together a 1-16” space 
will be left. This feature allows them to be snapped together thus deleting the gap.

Stack: This allows an item to be stacked above or below another item. This is available on many cabinets and select appliances.

Nomenclature - cabinet name can be moved and rotated on the plan.

Copy: This allows the copying of an item. If the selected item has any modifications, accessories, etc. these items will be copied 
as well.

Replace: This will allow a cabinet to be replaced with another cabinet without removing the existing cabinet. Example: Changing a 
B12 to a 4DB12. If the cabinet that is replacing the other cabinet is larger than the space available it will be place in the next available 
space on the end of the run of cabinets.

Delete: This allows the removal of an item from the plan. The item can also be deleted by clicking on the item and pressing the 
Delete key on the keyboard.

Add To Group: This allows the creation of a group and gives the ability to add an item to a particular group.

Change Catalog: This allows the ability to change from one catalog to another (must be the same manufacturer in an additional 
catalog). Example: An island and the parameter cabinets are designed out of one catalog, but the island is suppose to be another door 
style, wood species or finish. Use the Change Catalog option to change to the manufacturers duplicated catalog.

Attributes: This is where all the cabinet modifications, accessories, hinges specifications, finished ends, pricing, plan notation, etc 
can be set and/or changed.



18.2 DRAGGING AN ITEM
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18.2.1 Right-click on the item to be dragged, click on the item from the drop-down menu then click on the ‘Drag’ option from the 
second drop-down menu. The item will now drag along the plane (wall) that it is placed on until it hits another item. The item can be 
dragged past another item or wall by simply moving the cursor past the other item. Left-click to set the item.

18.2.2 Use the text boxes in the ‘Edit’ panel to set the exact placement of the item and press the ‘Enter’ key.

Project: Drag the B18R along the top wall and set back into its original position.

18.2.2

18.2.1



18.3 MOVING AN ITEM
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18.3.1 Right-click on the item to be moved, click on the item from drop-down menu then click on the ‘Move’ option from the second 
drop-down menu. The item can now be moved to another location on the design. The item can be placed inside or outside a place-
ment zone. If the item is placed outside a placement zone it will follow the mouse until the left mouse button is clicked. Left-click to 
set the cabinet.

18.3.2 If placed inside a placement zone use the text boxes in the ‘Info’ panel to set the exact placement of the item and press the 
‘Enter’ key.

Project: Move the B18R to the Left Wall and set it next to the Lazy Susan.

18.3.2
18.3.1



18.4 ROTATING AN ITEM
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Project: Move the B18R to a space outside the placement zone, on the grid, and set it into place.

18.4.1 Right-click on the item to be rotated, click on the item from the drop-down menu then click on the ‘Rotate’ option from the 
second drop-down menu. The item can now be rotated to any angle within the area in which it is placed. Left click to set the cabinet.

18.4.2 Use the text boxes in the ‘Info’ panel to set the exact angle of the item and press the ‘Enter’ key.

Project: Rotate the B18R and set outside a placement zone. 

Note: The cabinet will align with the wall.

18.4.2

18.4.1



18.5 45° CLOCKWISE, 45° COUNTER CLOCKWISE
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18.5.1 Project: Turn cabinet to 45° clockwise. Right-click on the item. In the menu choose 45° Clock-wise. The product will turn 
45° degrees.

18.5.1



18.6 MOVING AN ITEM IN/OUT
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18.6.1 Right-click on the item to be moved in or out, click on the item from the drop-down menu then click on the In/Out option 
from the second drop-down menu. The item can now be moved in and/or out from its original placement. Left click to set the item.

18.6.1



18.6 MOVING AN ITEM IN/OUT

146 PAGE PROKITCHEN TRAINING MANUAL

18.6.2 Use the text boxes in the ‘Info’ panel to set the distance of the item to be move in and/or out and press the ‘Enter’ key.

Project: Pull the Sink Base out 3” from the Top Wall. Place a 24”x30” Diagonal Wall Corner Cabinet (left hinge) in the corner above 
the Lazy Susan.

18.6.2



18.7 MOVING AN ITEM UP/DOWN
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18.7.1 Right-click on the item to be moved up or down, click on the item from the drop-down menu then click on the Up/Down 
option from the second drop-down menu. The item can now be moved up and/or down from its original vertical placement. 

18.7.2 Use the text boxes in the ‘Edit’ panel to set the distance from the bottom of the item to the floor or from the top of the item 
to the ceiling. Once the dimensions are entered press the ‘Enter’ key. This will set the item to the entered height.

Note: The direction menu is used for corner and end cabinets only. This menu changes the direction of the cabinet.

Project: Move the Diagonal Wall Corner Cabinet to 60” off the floor. Place any double bowl under mount sink into the Sink Base 
cabinet.

18.7.2
18.7.1



18.8 CENTERING AN ITEM
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18.8.1 Right-click on the item to be centered, click on the item from drop-down menu then click on the ‘Center’ option from the 
second drop-down menu. The item can now be centered on another object by clicking on the object to be centered on.

Project: Center the sink on the Sink Base Cabinet, pull the sink forward from the wall and place a single hole kitchen faucet in the 
countertop behind the sink. Place a B33 anywhere on the Left Wall.

18.8.1



18.9 POSITIONING AN ITEM
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18.9.1 Right-click on the item to be positioned, click on the item from drop-down menu then click on the ‘Position’ option from 
the second drop-down menu. The item can now be positioned a specific distance from another object. Click on the object that the 
selected item is to be positioned from and enter the distance in the ‘Info’ panel text boxes and press the ‘Enter’ key.

Project: Position the B33 18” from the left of the Lazy Susan.

18.9.1



18.10 FITTING AN ITEM
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18.10.1 Placing a larger item in a smaller space will cause a collision detection message to appear. This collision message is de-
signed to inform the user that the space is too small for the selected item. To fit the item, right-click on the item to be fitted, click on 
the item from the drop-down menu and click on the ‘Fit’ option from the second drop-down menu. The item can now be fit into the 
space by clicking back into that space. If the manufacturer allows width modifications the item will be resized to fit in the space. If 
the manufacturer does not allow width modifications the collision message will appear again. This indicates that the cabinet will not 
fit and a smaller cabinet needs to be selected for the space.

Project: Place a B18R between the Lazy Susan and the B33, use the ‘Fit’ option if necessary.

18.10.1



18.11 SNAP AN ITEM
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Project: Drag the B18R on the top wall next to the return wall on the right.

18.11.1 Right-click on the item to be snapped, click on the item from the drop-down menu then click on the ‘Snap’ option from the 
second drop-down menu. The item can now be snapped to the adjacent item by clicking on the adjacent item.

Project: Snap the B18R to the 18” Drawer Base Cabinet on the Top Wall.

18.11.1



18.12 COPY AN ITEM
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18.12.1 Right-click on the item to be copied, click on the item from the drop-down menu then click on the ‘Copy’ option from the 
second drop down menu. The item is now copied and can be placed into any placement zone or anywhere in the design.

18.12.2 Use the text boxes in the ‘Info’ panel to set the exact placement of the item and press the ‘Enter’ key.

Project: Copy the B18R to the island as shown below.

18.12.1



18.13 REPLACE AN ITEM
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This option is used to replace a cabinet with a different cabinet. Cabinets can be replaced with any sized cabinet from the same 
manufacturer. If the cabinet being changed is larger it will be placed in the next available space or to the end of the cabinet run.

18.13.1 Right-click on the item to be replaced, click on the item from the drop-down menu then click on the ‘Replace’ option from 
the second drop-down menu. The ‘Replace Product’ window will appear.

18.13.1



18.13 REPLACE AN ITEM
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18.13.2 Use the drop-down menu to change the catalog (if necessary). Use the search bar to find an item by SKU, description or 
both. Type in the text box and click the find button or press the ‘Enter’ key. A list of items appear in the window below. Highlight the 
new item and click the ‘Replace’ button or double-click on the description. This replaces the item.

Project: Replace the B18R in the island with an 18” Three-Drawer Base Cabinet.

Note: Use the Info button for the information window about the selected product.

18.13.1



18.14 DELETE AN ITEM
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There are two ways to delete an item.

18.14.1 Right-click on the item to be deleted, click on the item from the drop-down menu then click on the ‘Delete’ option from the 
second drop-down menu to delete the selected item. Click on the cabinet to be deleted. The item will show up with red lines. Press 
the ‘Delete’ key to delete the cabinet.

Project: Delete the 24” Diagonal Corner Cabinet using either method.

18.14.1



18.15 NOMENCLATURE
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18.15.1 You can move the description of the item on the plan by right-clicking on mouse.

Choose ‘Nomenclature Move’ or ‘Rotate’. By clicking ‘Move’ SKU is moving and you can display it to the desired location. Clicking 
rotate the description will rotate as you manage it with the mouse. To return the description in its place click Nomenclature > Default.

18.15.1



19.ATTRIBUTES WINDOW
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The ‘Attributes’ window allows access to the general information window about the item, allows accessories to be added and al-
lows modifications to be made to the selected item.

19.1 To show the ‘Attributes’ of an item, right-click on the item, select the item from the drop-down menu then click on the ‘Attrib-
utes’ option from the second drop-down menu.

Project: Bring up the ‘Attributes’ window for the B18R on the top wall.

19.1



19.1 THE ATTRIBUTES WINDOW - GENERAL TAB
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Use the right-click function or double-click on the item to access the ‘Attributes’ window. The ‘Attributes’ window shows the 
general information for the selected item. Each manufacturer will have different information in the ‘Attributes’ window. Some of the 
following information may be different or may not be available with select manufacturers.

Catalog/SKU - Shows the catalog that the item was selected from and the manufacturer’s SKU.

Description - Shows the manufacturer’s general category name. This can be changed in some catalogs to fit the needs of the re-
ports.

Plan Notation - Text in this box will override the item description on the floor plan, but not on the reports.

Quantity - Specifies the quantity of the selected item. The quantity can be changed in certain catalogs.

Pricing - Pricing can be changed (if the manufacturer allows) by using the up and down arrows or text box.

Cabinet Dimensions - Some manufactures allow the cabinet dimensions to be changed using these up and down arrows or text 
boxes. Other manufacturers only allow dimension modifications using the modifications tab. If the cabinet dimension modifications 
are found in the modifications window do not use the arrows to change the dimensions. The pricing will not me correct. Please check 
with Customer Service if you are unsure of how your manufacturer allows these dimension changes.

Doors, Tall Doors, Drawers, etc. - This option is available on select catalogs. This is where the door, shelf and drawer front count 
can be changed and will be added to the price of the selected item.

Auto Control - This option is available on select catalogs. This allows items to be configured outside the manufacturer’s specs. If 
this box isn’t checked, the pricing will be incorrect.

Add To BOM - Uncheck this box if the item isn’t to be shown in the Bill Of Materials. If this box is unchecked the item will not be 
priced into the design.

Spec Book - This button will direct the user to the manufacturer ‘s specification page for the selected product. In most cases the 
picture of the item will appear above the ‘Spec Book’ button.

Show Countertop - you can remove the tick and the product will not display the countertop. If a tick is checked then the product 
would be shown with the top.

Show XYZ - adds the coordinate axes on the product if we put a tick in the window.

Default Lighting - put a tick if you want to add a light to the item. Bulbs are automatically added. It can be seen by opening the 
cabinet door.

Close/Open - doors and drawers would open if you slide to the left or right.



19.2 ATTRIBUTES WINDOW - MODIFICATION TAB
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The Modification window shows the available modifications for the selected manufacturer. Each manufacturer will have different 
information and items available. Some of the following information may not be available with your manufacturer.

19.2.1 Use the Modification window to select the modification category.

19.2.2 By clicking the arrow to the right - accessories will add to the product, to the left - delete. When you click the double arrow 
all modifications will be removed from the product.

19.2.3 There are two categories in the bottom. ‘Expand All’ - opens all categories and you will see all available accessories.          
‘Collapse All’ - all opened categories would be closed.

Project: Remove Doors to the cabinet and then remove the modification.

19.2.3

19.2.2

19.2.1



19.3 ATTRIBUTES WINDOW - ACCESSORIES TAB
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The ‘Accessories’ window shows the available accessories for the selected manufacturer. Each manufacturer will have different 
information and items available. Some of the following information may not be available with your manufacturer.

19.3.1 Use the ‘Accessories’ window to select the accessory category.

19.3.2 Click on the desired accessory. The image of it will appear to the right and you will see how it looks. By clicking the arrow to 
the right - accessories will add to the product, to the left - delete. Pressing the double arrow, all added accessories would be deleted.

19.3.3 There are two categories in the bottom. ‘Expand All’ - opens all categories and you will see all available accessories. ‘Col-
lapse All’ - all opened categories would be closed.

Project: Add an accessory to the cabinet.

19.3.2

19.3.3

19.3.1



19.4 ATTRIBUTES WINDOW - SINK AND FAUCETS
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In Sink and Faucets tab you can add a sink and faucet and it will automatically install to the cabinet. To do this, choose a sink or 
faucet adapted for the appropriate cabinet. 

19.4.1 On the left drop down window choose which catalog you want to use for the sink and faucet. Available default Plumbing or 
if you have Kohler catalog it will also be offered in the list. Next, open the desired category.

19.4.1



19.4 ATTRIBUTES WINDOW - SINK AND FAUCETS
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19.4.2 Clicking with the mouse on the products there will appear a window with its description and size. When you choose the 
sink or faucet click on the arrow to the right and the product will automatically install. By clicking on the arrow to left you will remove 
product from cabinet. By clicking on the double arrow to the cabinet all added products would be removed.

19.4.3 There are two categories in the bottom. ‘Expand All’ - opens all categories and you will see all available accessories. ‘Col-
lapse All’ - all opened categories would be closed.

Project: Add an accessory to the cabinet.

19.4.3

19.4.2



19.5 ATTRIBUTES WINDOW - LIGHTING TAB
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You can add lighting to the cabinet in this tab.

19.5.1 Open the folder with the available lights. Pointing to them, you will see a picture. By clicking on the arrow to the right, the 
light will be added inside the cabinet. See it by opening the door. Clicking on the icon Duplicate the lamp would be copied and there 
will appear a second one. For this click the mouse in the right side of the window on the light which we want to duplicate.

Project: Add Lighting to the cabinet.

19.5.1



19.6 ATTRIBUTES WINDOW - KNOBS TAB
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In this tab, you can adjust the placement of the hardware on the doors, or even remove them.

19.6.1 To change the position of the hardware just click with the mouse on the right side of the window and then you can change 
the position of the hardware, move it vertically or horizontally, moving the circle with the mouse selecting the ‘Top’, ‘Center’, ‘Bottom’.

If you don’t want hardware to appear remove the tick near ‘Display Knobs’

19.6.1



20.1 PLACING PLUMBING FIXTURES
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20.1.1 To install the sink or faucet click the ‘Plumbing’ icon in the ribbon panel and in the open window you will see the available 
catalogs, options for sink, faucet, bath and so on. Select the product you need and drag it to the desired cabinet. Sink and faucet will 
be automatically placed at the correct height. Place the sink only in designated cabinets.

In the upper part of the window are located categories. Select desired catalog and you will see the products in the bottom. Click 
with your mouse on the product and on the right you will see 3D image. You can see Info by right-clicking on the product. This opens 
a window where you will see the product description and size.

You can also set the sink and faucet through the attribute dialog, as described in 18.20 paragraph.

20.1.1

20.1.1



20.1 PLACING PLUMBING FIXTURES
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20.1.2 Once the product is added on the plan you can edit, move, or turn it. Available in all the same steps as for cabinets (p.18.1). 
By right-clicking on the product, select Attributes. In the opened window in the General tab you can edit the size.

20.1.2



20.1 PLACING PLUMBING FIXTURES
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20.1.3 In the following Texture tab(Not available for all cabinets) you can select one from the texture. By clicking on a specific color 
the product will immediately change its color in the right window in 3D and you can see how it looks in the design.

To save the selected settings, click ‘OK’.

20.1.3



20.2 SWITCH SKU FOR INSIDE SINKS&FAUCETS
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When using the Switch SKUs the  built  in Sinks & Faucets will be installed in the switched cabinet if it is the appropriatesize. If the 
size of the sink or the faucet is greater than the cabinet, then it will not place in the cabinet, and at the completion of the Switch Sku 
operation, a message will be displayed stating  which items were removed from the cabinet due to a mismatch in dimensions.



20.3 BUILD-IN APPLIANCES (BUILD-IN OVENS)
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20.3.1 The Appliance tab, in the cabinet Attributes window, is available on all cabinets that can have an appliance placed into them.

20.3.2 Use these text boxes to set the height, width and the distance of the appliance cut-out from the floor.

20.3.3 Use the ‘+’ and ‘-’ buttons to increase/decrease the size of the picture in the cabinet window.

20.3.4 Once the cut-out dimensions are set click the ‘Add Appliance’ button to add the appliance into the cabinet.

20.3.5 Select the appliance to be placed into the cabinet using the appliance window as discussed. Choose an appliance that is 
close to the actual one. The dimensions can be changed in the next step.

20.3.6 Once the appliance is placed into the cabinet, the dimensions can be changed using the provided text boxes and/or arrows.

20.3.7 Once the appliance is set click the ‘OK’ button.

20.3.5

20.3.3

20.3.2

20.3.1



21.1 CHANGE COLOR/CREATE CATALOG COPY
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21.1.1 The design can have multiple textures for cabinets in one catalog. To implement this make a copy of the catalog and select 
other options for those products which you want to change color.

There are two variants to copy the catalog.

21.1.2 If you want to change the color of cabinets that already exist on the plan right-click on it and choose Change Color - Create 
Catalog Copy. In the new window name newly created catalog.

21.1.2



21.1 CHANGE COLOR/CREATE CATALOG COPY
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21.1.3 Click ‘OK’ and the program immediately prompts you to select options for this product in new catalog. After selecting YES 
you can choose the options you need in the new window. After choosing NO the window won’t appear. To select options you can click 
the Option button and choose new catalog. Moreover this catalog would appear in catalog list. All the products you choose will have 
options applied to the new catalog.

21.1.4 Running 3D you will see that the cabinet has changed color.

21.1.4

21.1.3



21.2 CATALOG SETTING – COPY CATALOG
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21.2.1 If there are no products on the plan that should differ in options you can copy  the catalog in another way. On the ribbon 
panel click ‘Catalog & Solutions’ > ‘Copy Catalog’. The program offers to save design, click ‘OK’, the design would close and you will 
see the list of catalogs. Select the catalog, the copy of which you want to do, and click ‘Copy’. Fill in Catalog Name, for example Cus-
tom2. Click ‘OK’.

21.2.1



21.2 CATALOG SETTING – COPY CATALOG
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21.2.2 Open the design and see new catalog Custom2 in the list. Select options, new catalog and add new options for it.

21.2.2



22.1 SEARCH TOOLS - FIND CUSTOMER
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22.1.1 Use the ‘Customer Search’ button to access the ‘Customer Search’ window.

22.1.2 Type specific information in the text box.

22.1.3 Select the search method.

22.1.4 If the name is found with the entered information it will appear in the ‘Search Results’ window. Click on the customer’s name 
to access the plan(s) for the customer.

22.1.5 The ‘Edit’ and ‘Delete’ buttons are used to edit or delete the customer information.

Project: Familiarize yourself with the ‘Customer Search’ feature.



22.2 SEARCH TOOLS - SEARCH DESIGN
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22.2.1 Use the ‘Search’ tab in ribbon panel if you need to find something. 

21.2.2 Type specific information in the text box. 

22.2.3 Select the radio button in which the search is to be searched. Search by ‘Order Number’, ‘Job Name’, ‘Contract #’, ‘P.O. #’, 
‘Status’, ‘Customer’ and ‘Date Range’. If searching by date range click the first ‘Calendar’ button and set the first date then click the 
second ‘Calendar’ button to set the second date. The program will bring up all designs between these dates. If the name is found 
with the entered information it will appear in the ‘Search Results’ window. Click on the customer’s name to access the plan(s) for the 
customer. 

Project: Familiarize yourself with the ‘Search Design’ feature.

22.2.3

22.2.2
22.2.1



23. SNAP BAR
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23.1 Right bottom on Elevation are Switch Bar. The panel includes the following switches:

GRID - Show Grid - show grid(on); ZONE - Show Wall Zones - enabling\disabling the wall trapping zone(off);MDIM - Display Dis-
tances on Mouse Navigation - display size at the point of moving the mouse(on);SNAP - Cabinet Snap - enable sticking mode at 
moving products and walls(on);GSNAP - Grid Snap - linking displacement product to the grid(on);

COL - Collision Detection - avoid collisions mode(on)

On the switch SNAP right click for the pop-up menu with a choice of sticking elements:

Endpoint - corners elements; Midpoint - midpoints of elements; Nearest - the nearest distance between the point and the side of 
elements.

23.1



24.1 PLACE LIGHTING FIXTURES
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24.1.1 Go to the catalog ‘Lightning’, in the ribbon panel, to add lightning or chandeliers to your room. Choose which lighting you 
need, the items are in the folder. In the right window you can see the image of it. When you have chosen the chandelier or spotlights 
drag it to the plan clicking ‘Place’ button.

When all lightning is chosen click Cancel to close the window.

24.1.1



24.2 LIGHTING WIZARD

178 PAGE PROKITCHEN TRAINING MANUAL

24.2.1 The lighting can be added inside of the cabinet. Right-click on the cabinet and select attributes.

Open the folder with available lights. Select your lighting . Click on the arrow to the right and the light will be added inside the cab-
inet. Open the door to see it.

Click the ‘Duplicate’ and the light will be copied. To do this click on the light you want to duplicate. To delete unnecessary light, 
click on it and click on the left arrow. You will see in the description area where the light is removed.

24.2.1



24.3 LIGHTING ATTRIBUTES
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24.3.1 Right-clicking on the light source will open a window - the light source can be moved, raised and lowered, centered, copied, 
turned off.

24.3.2 In Attributes you can edit the power of the light by moving the slider. In the Color field you can choose the color of the light. 
Click ‘Select’ and you will see the palette. Choose desired color and click ‘OK’.

24.3.2

24.3.1



24.4 AUTOMATIC SUN LIGHT
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24.4.1 Sun Lighting can be added automatically through the window. Click ‘Add Sun Lighting’ in Attributes Dialog box.

24.4.1



25.1 PLACE COUNTERTOPS
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25.1.1 To auto-build Countertop click ‘Add All’ button from ‘Ctops & Moldings’ tab on the ribbon panel.

25.1.1



25.2 COUNTERTOP EDIT
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Countertop can be edited. Right-click on it and you will 
see dialog window.

25.2.1 Drag - Right-click on the Countertop to be 
dragged, click on the Countertop from the drop-down 
menu then click on the Drag option from the second drop-
down menu. Left-click to set the Countertop. 

25.2.2 Move - Right-click on the Countertop to be 
moved, click on the Countertop from dropdown menu 
then click on the Move option from the second drop-down 
menu. The Countertop can now be moved to another lo-
cation on the design. Left-click to set the Countertop. 

25.2.3 Rotate - Right-click on the Countertop to be ro-
tated, click on the item from the drop-down menu then 
click on the Rotate option from the second drop-down 
menu. The Countertop can now be rotated to any angle 
within the area in which it is placed. Left click to set the 
countertop. 

25.2.4 In/Out- Right-click on the Countertop to be 
moved in or out, click on the item from the drop-down 
menu then click on the In/Out option from the second 
drop-down menu. The Countertop can now be moved in 
and/or out from its original placement. Leftclick to set the 
item.

25.2.5 Up/Down - Right-click on the Countertop to be 
moved up or down, click on the Countertop from the drop-
down menu then click on the Up/Down option from the second drop-down menu. The Countertop can now be moved up and/or down 
from its original vertical placement. Use the text boxes in the Info panel to set the distance from the bottom of the item to the floor 
or from the top of the item to the ceiling. Once the dimensions are entered press the Enter key. This will set the item to the entered 
height.

25.2.6 Copy - Right-click on the Countertop to be copied, click on the Countertop from the drop-down menu then click on the Copy 
option from the second drop down menu. The Countertop is now copied and can be placed into any placement zone or anywhere in 
the design.

25.2.7 Delete - Right-click on the Countertop to be deleted, click on the item from the drop-down menu then click on the Delete 
option from the second drop-down menu to delete the Countertop.



25.2 COUNTERTOP EDIT
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25.2.8 Right-click on the countertop to edit it. On the edge of the countertop appears red circles, pulling them you can change the 
shape and size of countertop. We can make the cut-out by right-clicking on the area where we want to make it and select Extrude. 

25.2.9 We can move a part of the countertop by right-clicking on the red edge and select Intersect. 

25.2.10 We can add one more point for shape changing by right-clicking on the edge of countertop and selecting Add Point. 

25.2.11 In order to round the countertop choose Radius End and drag the edge of the table top to the desired size. If you right-
click on the circle it will open another menu where the same editing process can be done: Delete Point - delete a point; Move - a point 
would be placed in the specified location; Bevel - cuts the corner at a 45-degree angle; Notch - cuts a rectangular segment. To save 
all settings and exit the edit mode you need to click on the white arrow on the top panel.

25.2.9

25.2.8

25.2.1125.2.10



25.3 COUNTERTOPS DESIGNER
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By right-clicking on the countertop - choose Countertops Designer. In the opened window we can change and edit the countertop, 
change angles, cut, profiles, add sink and so on.

25.3.1 Shapes - select the shape of any form that is represented in the top part of the window. Pull the slider to the left or right to 
see all proposed variations. Choose the appropriate Shape and click on it with the mouse, it will transfer to the countertop, one more 
click in the correct location and it will place. In the left part of the window you can set the sizes of sections.

25.3.1



25.3 COUNTERTOPS DESIGNER
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25.3.2 In Corners field you can change the countertop corners. Select the edge that is represented in the top part of the window 
and select the corners on the countertop where the selection is to be applied. Click with the mouse on the corners and they will take 
the form chosen. You can edit the size in the lower left panel.

25.3.2



25.3 COUNTERTOPS DESIGNER
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25.3.3 Segments - In this window, you can add/or cut a segment on the countertop. On the top of the window select desired 
segment by clicking on it with the mouse then select on the countertop by moving the mouse to where it should be placed(it can be 
moved) and it will show the placement location, when the segment is at the desired location, click the left button.

In the left panel is a dialog box where you can specify the size of the segment, set the angle and radius, set the off-set - right, left 
or center.

25.3.3



25.3 COUNTERTOPS DESIGNER
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25.3.4 Cutouts - in this window are cutouts for countertops. Choose the desired cutout by right-clicking on it and then click with 
the left button and its outline will appear on the countertop. Select where the cutout should be placed . In the left part of the window 
you can edit and move cutout. To delete added element - click on the top panel - “X”.

25.3.4



25.3 COUNTERTOPS DESIGNER
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25.3.5 Edge Profile - in this window you can select the edge for the countertop. Choose the desired profile by moving the slider. 
After selecting the profile; select with the mouse the edge of the countertop where it should be applied (it would be designated with 
a green color.

By clicking the mouse on the light green you can add or remove edges.

25.3.5



25.3 COUNTERTOPS DESIGNER
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25.3.6 Material - In this window, you can select a material for countertops. Click in the upper part of the window, select the material 
or create a new one by clicking ‘Add material’ and in the resulting window name your material. In the left pane, under the Image button 
press Select and in the opened a window are the available materials, select the material and click ‘OK’, (we can also set its price and 
thickness).Select Apply and click on the countertop or part of it - the material will be applied to the countertop. The material can be 
imported by clicking Import> User Collection window where you can take desired texture previously added (as described earlier in 
p.25.3.3)

25.3.6



25.3 COUNTERTOPS DESIGNER
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25.3.7 CNC Radius - in this window you can add CNC Radius. Click on the ‘Add CNC Radius’ button in the left pane and select the 
size. By clicking ‘Add to All’ - CNC Radius will be added to all the corners. Corners are denoted with circles. Clicking in the left panel ; 
Elements window, by selecting the radius you can change by clicking on it and using the up and down arrows, or delete the radius by 
clicking on the black cross. To remove all angles click ‘Delete All’. To add CNC Radius not to all but to a certain corner click on ‘Add 
CNC Radius’ button and enter the desired size.

25.3.7



25.3 COUNTERTOPS DESIGNER
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25.3.8 Add European Miter - adds a seam between the tops, at the 90-degree corner.

25.3.8



25.3 COUNTERTOPS DESIGNER
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25.3.9 Backsplash - in this window you can add Backsplash. Click ‘Add Backsplash’ and then appears a light green dot with a red 
outline of the backsplash, then specify which part of the countertops you want to add it to. In the left panel, set the desired sizes. 
Clicking on the white arrow at the top of the screen and the Backsplash will be fixed. To delete individual element Backsplash go to 
Element field and click from one element to another, these elements will be highlighted in the countertop. Select the desired element 
and click the “X” in the top tool bar and the element will be removed.

25.3.9



25.3 COUNTERTOPS DESIGNER
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25.3.10 Sinks - in this window the sink can be installed on the countertop. To do this, click on the Sink and in the opened window 
select the unit you want, and then click ‘Place’, select with the mouse where it needs to place.

25.3.10

25.3.10



25.3 COUNTERTOPS DESIGNER
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25.3.11 In the Appliances window you can install appliances on the countertop. Click on Appliances and in the opened window 
select the desired unit and click ‘Place’, select with the mouse where it needs to place.

25.3.11

25.3.11



25.3 COUNTERTOPS DESIGNER
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25.3.12 BOM - in this window you will see a list of all modifications applied with the dimensions. In the left panel you can set the 
price to each of them.

25.3.12
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25.3.13 Report - you can save and print created countertops by clicking ‘Export to PDF’. You can make CNC Integration, you can 
print by clicking ‘Print’.

25.3.13



25.3 COUNTERTOPS DESIGNER
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25.3.14 Summary - you can see all added and changed components by clicking ‘Place All’ - all changes are saved and will be dis-
played on countertop.

25.3.14



25.4 COUNTERTOP ATTRIBUTES
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25.4.1 Right-click on countertop , and choose ‘Attributes’. In the first tab General - You can change the width, height and depth of 
the countertop.

25.4.1



25.4 COUNTERTOP ATTRIBUTES
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25.4.2 In the second tab Texture you can choose a texture for your countertop.

Automatically is default. It means that all countertop would have one texture as have been chosen in Design Settings. If you want to 
change the texture click Special > Select. You will see a new window with textures.  Select the one you need and click ‘OK’. Then click 
“OK” again to close the window.

25.4.2



25.5 BACKSPLASH
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25.5.1 To add/remove Backsplash(es) click on the Countrtops & Molding button on the ribbon panel. Select Add All and it will set 
around the perimeter of the countertops.

25.5.1



25.5 BACKSPLASH
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25.5.2 Click the right mouse button and in the dialog window edit Backsplash. You can move it, raise, lower, copy or delete. 

25.5.3 Clicking Attributes would open a new window. In the first tab general you can change width, depth and height. In the second 
tab Texture - you can select a texture for Backsplash. There are 4 options: 

1. As Countertop - Backsplash would take countertop color. 

2. Match Catalog - Backsplash would take a color of the cabinet. 

3. Select Non Wood - click Select and choose from the offered textures. 

4. Select Wood - click Select and choose from the offered wood textures.

25.5.3

25.5.2



26.1 PLACING MOLDINGS
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26.1.1 To place the molding(s) that were selected in the ‘Design Settings’ click on the Countertop & Molding button. Select Add All 
and the selected moldings will be placed into the design.

26.1.1



26.1 PLACING MOLDINGS
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26.1.2 To stack moldings select the first molding from the drop-down list (typically a sub-crown or an a L-Shape Molding). Drag 
and drop the molding to the top of the cabinet in which it is to be placed. If cabinets are at different levels the molding will need to be 
placed onto each level. The next molding is placed in the same manner and will be stacked onto the first molding.

Note: Moldings are placed on the open sides of cabinets and counts the exact linear footage. Add additional moldings in the ‘Bill 
Of Materials’ for waste and miscuts. See the ‘Countertop’ section for editing moldings. Moldings are modified similar to countertops.

26.1.2



26.2 MOLDINGS ATTRIBUTES
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26.2.1 Molding can be edited by clicking the right mouse button. In the new window are the following options: drag, move, rotate, 
up/down , replace, delete, change color (options as for the cabinets, see p18).

26.2.1



26.2 MOLDINGS ATTRIBUTES
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26.2.2 When you select the command Edit - molding can be moved by pulling the red circle, you can change its shape, stretch, or  
move. By right-clicking on the red area of molding , the program will offer 4 types of changes - Extrude - add a point, which would 
make the notch. We can move the molding by right-clicking on the red box and select Intersect. By right-clicking on the molding and 
selecting Add Point we can add one more point if it is necessary for form changing.

You can round off the selected molding by selecting Radius End and dragging the edge of the molding to the desired size.

If you want to make part of the molding invisible after selecting Edit right-click on the right location and select Disable. The part 
that is not visible in 3D would be shown by dotted line on the plan. To save your changes and exit the edit mode, you need to click on 
the white arrow on the top panel.

26.2.2



26.2 MOLDINGS ATTRIBUTES
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26.2.3 If you right-click on the circle it will open up another menu which also works with editing:

Delete Point - Delete Point

Move - a point will be moved to the specified location;

Bevel - cuts the corner at a 45 degree angle;

Notch - cuts a rectangular segment

26.2.3



27.1 ZOOM TOOLS
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27.1.1 Click the ‘Zoom In/Out’ button to move the design in and out. Left-click on the Plan/Elevation to zoom in, right-click to zoom 
out.

27.1.2 Click the ‘Zoom Into Region’ button to zoom into a select region. Left-click on the Plan/Elevation and drag the mouse to 
draw the Zoom-In region, left-click again to end drawing the Zoom-In region.

27.1.3 Click the ‘Zoom To Fit’ button to fit the plan to the current Plan/Elevation window.

27.1.4 Click the ‘Select’ button to clear the cursor.

Note: Use the center mouse wheel to zoom in and out. Hold the center mouse wheel down as a button to move the floor-plan view.

27.1.3

27.1.227.1.1

27.1.4



28.1 BILL OF MATERIALS (BOM)
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28.1.1 Use the ‘Bill Of Materials’ button to access the Bill Of Materials panel.

28.1.2 There are three tabs in the BOM panel. Plan Items are items that show in the floor-plan, Elevations and 3D view. Non-Plan 
items are items such as extra moldings, panels, extra cabinets, toe kick covers and items that do not appear on the floor-plan, Ele-
vations or in the 3D view, but will be included in the reports. Additional Products are items that have been previously quoted by the 
manufacturer (special orders) or other products that are to be included in the Customer Reports.

28.1.3 There are eleven buttons located within the BOM panel. These buttons are for: Information about the selected item, Deleting 
an item from the BOM (this will also remove it from the plan), Editing an item, Copying an item, Replacing an item, Moving items up 
and down in the BOM list and Numbering the items on the floor plan.

28.1.3

28.1.2

28.1.1



28.2 BOM - PLAN ITEMS
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28.2.1 Use the ‘Information’ button to display info about an item. Highlight the item and click the Info button or double-click the 
item. 28.2.2 Use the ‘Delete’ button to delete an item. Highlight the item and click the ‘Delete’ button.

Note: This also deletes the item from the design plan.

28.2.3 Use the ‘Edit’ button to edit an item. Highlight the item and click the ‘Edit’ button. This brings up the Attributes window. 
28.2.4 Use the ‘Copy’ button to copy an item. Highlight the item and click the ‘Copy’ button. Place the copied item into the design. 
28.2.5 Use the ‘Replace’ button to replace an item. Highlight the item and click the ‘Replace’ button to bring up the Replace window. 
28.2.6 Use the ‘Up’ button to move items up in the BOM list. This will change the cabinet number on the plan. 28.2.7 Use the ‘Down’ 
button to move items down in the BOM list. This will change the cabinet number on the plan. 28.2.8 Use the ‘Display Labels’ button 
to number the cabinets on the design. This places the BOM numbers on the design.

28.2



28.3 BOM - NON-PLAN ITEMS
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The Non-Plan Items window utilizes the same buttons as the Plan Items window.

28.3.1 Click on the Non-Plan Items tab to access the Non-Plan Items window.

28.3.2 Use the catalog window to access the Non-Plan Items. Once an item is selected, drag and drop the item into the Non-Plan 
items window. This will place the selected item into the reports.

28.3.3 To change the quantity of the selected item(s) double-click the item to bring up the Attributes window. Use the provided text 
box to set the new quantity for the item(s).

28.3.3

28.3.2

28.3.1



28.4 BOM - FACTORY QUOTED ITEMS
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The Additional Products window is used for items that have been previously quoted from the factory or items that are to be added 
to the customer report such as; countertops, construction, sinks, faucets, appliance etc.

28.4.1 Use the Additional Products tab to access the factory quoted items and additional products window.

28.4.2 Use the ‘Add New Factory Quote’ button to access the factory quoted items and additional products window.

28.4.3 To place a factory quote item or an additional product select the manufacturers catalog or My Products, set the quantity, 
type in a brief description, type in the quote number (or SKU number for Additional Products) provided by the manufacturer, set the 
list price and type in any notes for the item then click the ‘OK’ button. This will place the item into the Additional Products window.

28.4.3

28.4.2
28.4.1



29. MEASUREMENTS
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There are six different types of dimensions that can be placed on a floor plan. Access the different dimension types by using the 
‘Measurements’ drop-down menu or using the ‘Measurements’ buttons.

29.1 Use the ‘Horizontal’ button to show a dimension between two horizontal points.

29.2 Use the ‘Vertical’ button to show a dimension between two vertical points.

29.3 Use the ‘Point-To-Point’ button to show a dimension from a point and another point.

29.4 Use the ‘Angular’ button to show the angle between two points.

29.5 Use the ‘Point To Line’ button to show a dimension between a line and point.

29.6 Use the ‘Line To Line’ button to show a dimension between two adjacent lines.

29



30.1 DECORATIVE ITEMS
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ProKitchen has many different Architectural Elements such as base boards, crown moldings, etc. There are also decorative items, 
furniture and lighting fixtures that can be placed into the design. Using these elements creates a more realistic view in 3D.

30.1 The Decorative Items and Architectural Elements are found in the Catalog panel or by using the ‘Lighting’, ‘Furniture’ or ‘Dec-
orative items’ buttons on the ribbon panel. They are placed into the plan in the same manner as other items.

Note: Many decorative items are set at kitchen countertop height. Many light fixtures are set at 96” high, so if the ceiling is higher 
they may need to be raised. Most furniture items are set at floor level. Always check the height placement of decorative items.

30.1

30.1



30.2 REV-A-SHELF
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30.2.1 Catalog Rev-a-shelf - is a catalog with a variety of accessories that you can use in design. It is located on the left side in 
the list of catalogs. It includes various accessories for inside cabinets for the kitchen and bath.

30.2.1



30.3 FURNITURE
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30.3.1 In the catalog you will find a variety of Furniture for your designs. Catalog is in the left panel, all the furniture is divided into 
categories. Select the desired item and drag onto the plan. You can edit, rotate and move it by right-clicking on the product.

30.3.1



30.4 CLOSET DESIGNER
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30.4.1 Closet Catalog is designed to create a wardrobe or a separate compilation of furniture. The catalog consists of individual 
partitions, shelves, panels and so on. Catalog can be installed in the left panel. 

30.4.2 Designing closets. All the closet edits are done on the elevation window where only closet with its components are shown 
without any other plan items. At one time user can work with only one closet run along one wall. Modules are added to the closet from 
left to right. When adding a new module alongside existing one the center panel (drilled through) should be inserted between them. 
In other words when adding or deleting modules the vertical panels have to be altered as well. User can start building a new closet in 
3 different ways: a) select a system template from the Design Ideas; b) drag modules (towers) from the catalog window (on the left 
panel); c) build a complete new closet from the closet catalog items (vertical panels, shelves, etc) by: first adding vertical panels; then 
inserting all other closet components and accessories.



30.4 CLOSET DESIGNER
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30.4.3 ProKitchen Global options applies to the closet in the same way as they applied for other plan items (e.g. cabinetry).

- All the modules and individual components of the closet are listed in the BOM;

- BOM contains all the hardware needed for closet installation;

This can be achieved by manually adding these items on the non-plan section or automatically by extending the behavior and prop-
erties of each closet component so we can figure out which hardware we need to combine components between each other.

30.4.4 To create Closet section select the wall on which you want to create it, and click the ‘Closet’ icon on the left panel.

30.4.1

30.4.4



30.4 CLOSET DESIGNER
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30.4.5 Opens a window in which you will create a Closet. The first tab Closet - an information tab, set the size of the wall that you 
have chosen to create a Closet. In the Actions - You can specify how to arrange the section - Place at Wall, Align left, Align right, Set 
Margin, Add Molding. Put a check in the Sync Plan to display builds on the plan. If you do not need remove the check mark .

30.4.6 In the tab Default - sets the size of the section, select Mounting - Floor or Wall Standing. Put a tick in the Add Shelves at top 
and bottom if we want to set the shelf on the top and bottom. In the Count Of Section select the number of sections of the selected 
size. Next, specify the field where construction Before or After should be placed . If you have finished section you must specify with 
the mouse and click before or after it where the next sections should be built. When the section sizes are chosen, click on the green 
plus sign on the installation section of the plan. You can remove sections clicking on the red”X”.

30.4.5 30.4.6



30.4 CLOSET DESIGNER
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30.4.7 In Section tab - are the size and description of the section. In the Actions - you can add or remove the right or left panel, 
raise or lower section, change the width, add a corner section, bridge to another closet.

30.4.7



30.4 CLOSET DESIGNER
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30.4.8 In the Doors tab you can add a door to the closet. In the field doors - choose a door from the directory, in the window Hinges 
- select L, R, Pair. In the level field - select the level at the top or bottom to set the door. Referring to the section click - Add doors. 
Doors added.

30.4.8



30.4 CLOSET DESIGNER
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30.4.9 In the Shelving tab you can add shelves. In the Shelves field select the type of shelves. In the Count field - the number added 
to the section. When choosing shelves they accommodate proportionally. In the Place choose where to install the shelf at the bottom, 
top or on the entire section. You can set the interval with which the shelves set into the section. By putting a check in the Add divid-
ers they would appear on the shelves. In the Dividers choose from the catalog and in the Count field you need to put the number of 
dividers. Click ‘Replicate’ and shelves will set in section. If you want to add Dividers specify the shelf by clicking the mouse and click 
‘Place’.

30.4.9



30.4 CLOSET DESIGNER
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30.4.10 In the hardware tab choose Rail in the Rail Cover field. If the rail does not need to be installed and does not need to be 
counted, then remove the check mark. Select Hanger Cover from the list if you do not need their calculation and installation, then 
remove the check mark from the Include Panel Hangers. If you want to include Closet Support Fillers - then put a tick in the box.

To count all the Hardware click Update under ‘Add Hardware at BOM’.

All selected items will be displayed in the BOM in the Non-Plan items tab.

30.4.10

30.4.10



31.1 ADDING COMMENTS
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31.1.1 To add a comment to the design select Comment on the menu bar and choose Add Comment. 31.1.2 Select the point where 
the comment is to be placed on the design and left-click. 31.1.3 Type the comment into the text box and click the ‘OK’ button. 31.1.4 
To assign a tag to the comment use the drop-down menu and select the Tag Number. To change the font color on the comment click 
on the Select Font Color button and choose the desired font color. To change the font type, size and/or format use the drop-down 
menu and/or corresponding radio button. To show the comment on all the plan views click the All Views radio button. To show the 
comment on selected views click the Selected Views radio button, then choose the plan view that the comment is to show on.

Note: A tag is used to make a comment about a particular numbered item. Comments are moved, rotated, deleted and editing used 
the right-click function.

31.1.5 To add a line to the design click the Add Line menu, select the starting point, drag the cursor to the ending point and left-click. 
To add an arrow to an end of the line, right-click on the line and select the end of the line that the arrow is to be placed and left-click.

31.1.5

31.1.3

31.1.1



31.2 ADDING LINE OR SCHEMATIC LINE
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31.2.1 To add a line to the design click the ‘Add Schematic Line’ menu, select the starting point, drag the cursor to the ending point 
and left-click. To add an arrow to an end of the line, right-click and select the end of the line that the arrow is to be placed and left-
click.

31.2.1



32.1 3D VIEWS
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32.1.1 Use the Rotate buttons to rotate the 3D view.

32.1.2 Use the Move buttons to move the 3D view.

32.1.3 Use the Zoom buttons to zoom in and zoom out the 3D view. Click and hold the right mouse button to rotate the 3D view. 
Click and hold the left-mouse button to move the 3D view. Click and hold the center mouse wheel/button to zoom in and zoom out 
the 3D view.

Note: Do not roll the wheel.

Project: Show a 3D view. Use the mouse and navigation buttons to rotate and show the design.

32.1.1 32.1.3
32.1.2



32.2 SAVING 3D VIEW
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32.2.1 Use the ‘Save To File’ button to create a JPEG file of the current view.

32.2.2 Use the drop-down menu to select the folder where the new JPEG is to be saved.

32.2.3 Type in the saved JPEG name into the text box.

32.2.4 Click on the Save button to save the JPEG. The JPEG can now be emailed as an attachment.

32.2.5 Use the Print button to send the current view to the printer. Standard printer functions settings are applied.

Project: Create and save a JPEG file of the current 3D view.

32.2.1 32.2.5



32.3 CHANGING DOOR STYLES IN 3D
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32.3.1 Use the ‘Door Style’ button to change the cabinet door style(s), species and colors in the 3D tab.

32.3.2 Select the catalog to be changed using the drop-down menu.

32.3.3 Select the item to be changed by clicking on the description. This brings up all available options.

32.3.4 Select the item by double-clicking on the desired selection. This changes the 3D view.

32.3.5 The selections will show in the product window.

32.3.6 To reset the 3D back to the original colors click the ‘Reset Parameters’ button.

Project: Change the colors and door styles in the 3D view.

32.3.6

32.3.5

32.3.4

32.3.2

32.3.1

32.3.3



32.4 CHANGING WALLS, COUNTERTOPS & FLOORS IN 3D
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32.4.1 Use the ‘Countertop’, ‘Flooring’, ‘Walls’ and/or ‘Ceiling’ buttons to change the colors in the 3D view.

32.4.2 Use the category list to search materials to be used for the selected item.

32.4.3 Use the search box to search items by color, pattern, material etc.

32.4.4 Once the category is selected click on the small sample to show it in the larger window on the right. Click on the ‘Add To 
Favorites’ button to add the selected color to the favorites window.

32.4.5 Once the selection is made, click on the ‘Apply’ button to show it on the 3D view. Double-clicking on the item will also set it 
into the plan. Click on the ‘OK’ button to close the window. Click on the ‘Cancel’ button to cancel out of the window. The Countertop, 
Flooring, Wall and Ceiling windows work in the same fashion.

Project: Change the countertop, flooring, walls and ceiling in the 3D view.

32.4.4

32.4.2

32.4.3

32.4.5

32.4.1



32.5 INVISIBLE WALLS
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32.5.1 Use the ‘Hide Invisible Walls’ button to hide items as the wall is rotated. Walls, cabinets and countertops disappear as the 
walls are rotated so that the front on the island can be seen.

32.5.2 Use the ‘Light’ button to change the intensity of the light source. Slide the arrow to set the intensity or use the text box. Use 
the ‘Exit’ button or click on the red X to close the 3D window.

32.5.232.5.1



32.6 LIGHTING IN 3D
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32.6.1 In the 3D we can edit lighting, increase or decrease the intensity of the light sources, change color, delete or disable them. 
Clicking on the icon Lighting will open the window with a list of all light sources that are used in the design. You can edit it in the 
lighting tab. If you remove a tick from the Enable the light will be turned off.

32.6.2 Pull the slider for Intensity - increases and decreases the light output.

32.6.3 Pressing Select next to color you can choose the color of the light.

32.6.3
32.6.2

32.6.1



32.7 HD RENDERING IN 3D
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32.7.1 For rendering images set the desired angle. Selected angle can be saved - just click ‘Saved Views’. Select ‘Saved View’ - 
opens a window, enter the name of the saved view. When you reopen the saved 3D view will be available in the Saved View field. It can 
be removed by clicking ‘Remove View’. You can click ‘Set as Default’ so then every time you open the 3D it will be opened in this view.

32.7.2 Click on the ‘HD’ button. Opens a window in which you can set the settings for rendering.

32.7.1

32.7.2



32.7 HD RENDERING IN 3D
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32.7.3 Set the brightness of the picture with the help of the slider. Below choose Resolution. If a dark finish is used you can put a 
tick in the box Additional Highlight. For best quality put a tick in the box Maximum image quality.

32.7.4 You can set the level of the glaze and haze for floors, walls, countertop, windows and appliances .If you put the slider on 
matte - the surface would be matte and would not reflect. Glossy - will give a glossy surface.

32.7.5 When you have set the desired parameters click ‘Preview’. The picture will change in accordance with the selected param-
eters.

32.7.6

32.7.4

32.7.5

32.7.3



32.7 HD RENDERING IN 3D
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32.7.6 Click ‘Render’. Opens a large window, the image begins to render. 

32.7.7 When the image is ready, in the upper left corner you will see an active floppy and printer icon. The picture can be printed 
and saved. By clicking save, you will be prompted to select the path and image format.

Important! If you do not save the picture and just close the window, it will not be saved automatically!

32.7.7



33.1 CREATE NEW PANORAMA
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33.1.1 To create the panorama click ‘Create Panorama’. In the opened window in the Panorama Name - enter the name.

33.1.2 Select the camera position, the default is Center Position and the camera will be on the middle of the room. If you select 
Move Camera, while pulling, it will be moved. In the background in 3D you will see an overview of the image covered by the camera. 
Pulling the blue circle you can reduce or increase the length of the review.

33.2.1

33.1.2

33.1.1



33.2 PARAMETERS OF PANORAMA
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33.2.1 Choose Rendering Quality - standard or maximal. Select resolution. When all options are selected click - ‘OK’. Panorama 
starts rendering. When it is completed panorama will automatically open in a browser by default.



33.3 SAVING PANORAMA
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33.3.1 To download and save a panorama click ‘Panorama’ button.

In the list you will find the desired panorama by name or by date(if the name of panorama is the same). Also there are Quality and 
Resolution in the list.

To download the panorama click ‘Upload’.

33.3.1



33.3 SAVING PANORAMA
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33.3.2 When the panorama is loaded we can view it by clicking - Preview. You can send it - put a tick next to the desired pan and 
click ‘Send’. The address box will be opened where you specify the recipient.

33.3.2



33.3 SAVING PANORAMA
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33.3.3 You can copy the link by clicking the right mouse button.

33.3.3



33.3 SAVING PANORAMA
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33.3.4 To delete the panorama select it with the mouse and click ‘Delete’.

‘Close’ - to close the window.

33.3.4



34.1 PROKITCHEN-OCULUS
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34.1.1 In ProKitchen there is the possibility to browse designs in Oculus (Virtual Reality).To do this you need to make a design 
export Oculus Rift.Rvo.

34.1.1



34.1 PROKITCHEN-OCULUS
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You must install the program ProKitchen Oculus, connect it and you can run the file.



35.1 MANUFACTURER’S REPORT
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35.1.1 To create a cost and parts list for the order, click the ‘Manufacturer Report’ button from the ribbon panel to open the Select 
Catalog window.

35.1.2 Some manufacturers allow additional discounts. To add an additional discount double-click on the Other Discount text box 
and enter the discount percentage. Once all discounts and any additional notes are entered, click on the ‘OK’ button. This creates the 
manufacturer’s report. Each manufacturer requires different information.

Note: A manufacturer’s report needs to be created for each catalog used in the design.

35.1.1



35.2 CUSTOMER REPORT - CATALOG SETTING TAB
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35.2.1 To create a price and/or parts list for the order click the ‘Customer Report’ button from the ribbon panel.

35.2.2 the Customer Report window will appear.

35.2.3 To select the catalog, highlight the catalog description.

35.2.4 Use the Include Catalog In Customer Report check box to include the information in the report.

35.2.5 To set the tax enter the percentage in the text box.

35.2.6 The design, shipping and installation charges are set as a percentage or a dollar amount. Use the check-boxes to apply 
sales tax to each item (if applicable).

35.2.7 The Discount text box is used to set a discount off the MSRP.

35.2.7

35.2.5
35.2.6

35.2.2

35.2.1

35.2.4

35.2.3



35.3 CUSTOMER REPORT - LOGO TAB
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35.3.1 To insert a logo into the report click the ‘Browse’ button and select the logo and click the ‘Open’ button.

35.3.2 To include text on the top and/or bottom of the Customer Report use the provided text boxes.

35.3.1

35.3.2



35.4 CUSTOMER REPORT - PRICING TAB
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35.4.1 To select a catalog, use the drop-down menu and click on the catalog. This brings up all the items in the design from the 
selected catalog.

35.4.2 To change the installation price of a cabinet, double-click the price text box and type in the new price. If pricing the instal-
lation by the job (flat rate) leave the installation box on the Catalog Settings page at $0.00 and change the install of one cabinet on 
the Pricing page to the flat rate price.

35.4.2

35.4.1



35.5 CUSTOMER REPORT - PROJECT SETTINGS
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35.5.1 The project settings window is information that will appear on the Customer Report.

35.5.1



35.6 CUSTOMER REPORT - SAMPLE REPORTS
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The Customer Report includes all cabinets and accessories in the plan including multiple catalogs.

Note: The navigation button works the same as the Manufacturer Report.



35.7 MULTI-QUOTE REPORT
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The Multi-Quote option is used to view up to five door styles side by side on one report. The Multi-Quote option is not available for 
all manufacturers.

35.7.1 To create a Multi-Quote click on the ‘Multi-Quote’ button from the top toolbar. 35.7.2 Use the drop-down menu to select the 
cabinet line to be used for the Multi-Quote.

35.7.3 Use the ‘Number Of Quotes’ up/down arrows to select the number of different quotes needed. The number of quotes                    
selected will show as tabs in the Compare Quotes window.

35.7.4 Use these text boxes and radio-buttons as discussed in the Customer Reports section.

Note: The Catalog Settings, Include and Project Settings tab work in the same manner as discussed in the Customer Reports      
section.

35.7.4

35.7.2
35.7.3



35.8 MULTI-QUOTE REPORT - QUOTE WINDOWS

249PAGEPROKITCHEN TRAINING MANUAL

35.8.1 Use the Quote Number tabs to select the individual quote windows.

35.8.2 Use each Quote window to set the values for each quote tab.

Note: All ‘Please click to select’ options must be selected.

35.8.1



35.9 MULTI-QUOTE REPORT - SAMPLE REPORTS
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35.9.1 The Multi-Quote Report includes all cabinets and accessories in the plan including multiple catalogs in multiple finishes, 
door styles, line and species.

Note: The navigation buttons work in the same as the Customer Report.



35.10 BOM REPORT
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35.10.1 Bill Of Material Report - called BOM, by pressing the BOM Report - provides a list of products and prices.

35.10.2 If you click BOM Report No Pricing - it generates a report with a list of products with dimensions but without prices.

35.10.2

35.10.1



35.11 QUICK REPORT
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35.11.1 Generates full report on the entire design, including a list of products, prices, options, pictures with the plan, 2D and 3D. To 
generate this report click on the ‘Quickreport’ button on the ribbon panel. You can edit, add comments, save and print the file in PDF 
format.

35.11.1



35.12 SHARE BY EMAIL
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35.12.1 Ready designs can be mailed. In the filetab click Share > Send Using E-Mail. Choose where to send and what to attach to 
the letter.

35.12.1



35.13 COMBINED REPORT
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35.13.1 Combined Report can create report of several reports or PDF files. 

Click ‘Combined Report’ and in opened window you are prompted to add a file from your computer, remove the file, swap files - UP/
Down and view the result with the ‘Preview’ button.

35.13.1



35.14 EZ LINK - ELECTRONIC ORDER
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35.14.1 Not available for all catalogs.

Click the button on the ribbon panel. Program export design data and save the selected format on a server. This file can then be 
imported into other programs.

35.14.1



36. EXPORT
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36.1 ProKitchen allows you to export design in different files and use in other programs, such as: AutoCAD, GoogleSketchUp, 
QuickBooks, and others.

36.1



36.1 AUTOCAD
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36.1.1 To export the design in AutoCad, press export - AutoCad. In a new window choose what data needs to be exported(select 
with a tick). Press the Select / Unselect - you can select or remove all at once.

Click ‘Browse’ to select the path to save the file. Then click Export and you will get the message that export is ready.

36.1.1



36.2 GOOGLE SKETCHUP
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36.2.1 To export the design to Google SketchUp click export- Google SketchUp. In the new window is a way to save, choose it and 
click Save. Design would be saved in 3ds format, and you have an opportunity to open it in SketchUp.



36.3 QUICK BOOKS
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36.3.1 To export to Quick Books click export - QuickBooks All Customers.iff or QuickBooks Current Design.iff. QuickBooks All Cus-
tomers exports data on all customers and QuickBooks Current Design exports data about the design. After clicking export it opens a 
window. Now, by making import into QuickBooks, you can work with data from ProKitchen.

36.3.1



36.4 PROKITCHEN SHOWROOM
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36.4.1 Design can be exported to ProKitchen Showroom for further work in this program. Go to export - ProKitchen Showroom. 
choose to save the file. When export is ready you can open the file in ProKitchen Showroom.

36.4.1



36.5 IPHONE/IPAD/ANDROID
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36.5.1 To work with the design on the iPhone/iPad/Android you should do export. Go to export - iPhone/iPad/Android.RVD, choose 
the path to save.

36.5.1



36.6 PROKITCHEN-OCULUS (VIRTUAL REALITY)
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36.6.1 To make export of the design in Oculus Rift. Rvo go to export - Oculus Rift. RVO, choose the path to save click ‘Save’. To 
view the file you need to install ProKitchen Oculus and connect Oculus.

36.6.1



36.7 PROKITCHEN USER DATA
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36.7.1 To save all the settings when you reinstall ProKitchen or transfer it to another computer you can make an export with all 
settings and options selected. Use ProKitchen User Data.zip for it.

36.7.2 Opens a window where you need to specify which data is to be exported. Tick on the desired items and click ‘OK’. The pro-
gram will offer to choose the path for the file. Select the path and click ‘OK’. Data will be saved in this folder.

36.7.1



37. IMPORT
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37.1 These allow importing of vital information in the program such as the customer data base, solutions, dealer information, 
design files, print settings and default settings. This function is used if transferring the program from one computer to another.         
ProKitchen gives the opportunity to use files of various formats for viewing.

37.1



37.1 AUTOCAD
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37.1.1 To import files from AutoCad, press the File > Import > AutoCad.dxf, dvg. In a new window you need to find the file you want 
to upload to ProKitchen and click ‘Open’.

37.1.1



37.2 PROKITCHEN USER DATA
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37.2.1 To import ProKitchen settings that were previously exported click import - ProKitchen User Data.zip. In the opened window 
find the path to the desired file, and click ‘OK’.

37.2.2 Opens a window in ProKitchen with a list of data that is stored in the file, removing or adding a tick, you need to select which 
data you want to import. Click ‘OK’.

37.2.3 Opens a window with the message of duplicate items and the option to replace data yes or no.

37.2.1

37.2.237.2.1



37.3 IMPORT SOLUTION
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37.3.1 To import Solutions go to File > Import > ProKitchen Solutions.grp. A window opens in which you need to find the way in 
which the file was stored and selecting it click ‘Open’. Solution opens in design.

37.3.1

37.3.1



37.4 MAGIC PLAN DESIGN FILE
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37.4.1 File > Import > Magic plan Design File allows you to import Magic plan Design and work with it in ProKitchen.

37.4.1



38.1 IMPORT SKETCHUP MODELS
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38.1.1 ProKitchen allows you to use various models of the 3D model Browser in design.

Click on the ‘3D model Browser’ button on the ribbon panel. Opens a window and in the first tab 3D warehouse you enter what 
you’re looking for and the program displays all the possible options.

38.1.1



38.1 IMPORT SKETCHUP MODELS
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38.1.2 After selecting the appropriate model click on the red arrow and load it. Model opens in ProKitchen. Adjust the desired size 
and description and add to the plan by clicking the button ‘Add To Design’.

37.1.2



38.1 IMPORT SKETCHUP MODELS
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38.1.3 In the second tab, 3D Models - are located previously saved and downloaded models. To use it click on the right by            
double-clicking and it will open a window where you can edit description, size and add to design.

38.1.3



39.1 PRINT PREVIEW
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39.1.1 Use the ‘Print’ > ‘Print Preview’ from the File-tab menu.

39.1.2 To set the orientation of the prints select the ‘Setup’ button.

39.1.3 Use the Size drop-down menu to select the paper size. Use the Source drop-down menu to select the printer source. Select 
the orientation of the page using radio buttons. Use the text boxes to set the margin dimensions.

Hint: The smaller the outline margins the larger the print area will be.

39.1.3

39.1.2
39.1.1



39.1 PRINT PREVIEW
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39.1.4 Use the ‘Stamp’ button on the Print Preview page to change the text on the printed views. Click on the Text tabs to select 
the text to be changed. The width and height of the text boxes can be changed by using the Width and Height text boxes. The font in 
each text box can be changed using the Font drop-down menus and radio buttons.

39.1.4



39.1 PRINT PREVIEW
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39.1.5 Print Scale - Fit To Page al-
lows the drawing to fit to the selected pa-
per size. Ratio allows the drawings to be 
drawn to scale.

39.1.6 Print Area - Entire Design prints 
the complete design on the page. Display 
prints what is currently displayed on the 
screen.

39.1.7 Page Range - Select All Views to 
print all the floor-plan view (tabs). Select 
Plan View to print the current floor-plan 
view (tab). Select “Selected Views” and 
click the Browse button to select specific 
view(s) to be printed.

39.1.8 Check the boxes of the views to 
be seen in the print preview.

Note: Elevations must be created be-
fore they can be printed.

Once all selections are made click the 
OK button to go back to the Print Preview 
window then click the OK button to pre-
view the pages to be printed.

39.1.9 Use the ‘Print’ button to skip all the above steps and print all views.

39.1.10 Use the ‘Print’ button to print all previewed floor-plans and/or elevations. Use the ‘Close’ button or the red X to close the 
current window. Use ‘Zoom In’, ‘Zoom Out’ buttons or the drop-down menu to zoom in and/or out on the current screen. Use the 
‘Mover’ button to move the floor-plan or elevation on the page. Click on the ‘Mover’ button then click on the design to move within the 
page. Use the arrows or text boxes to change the scale of each selected view. Use the page box to move from view page to view page.



39.2 PRINT TEMPLATE
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39.2.1 It is possible to select a template to print designs. Use ‘Print’ > ‘Print Template’ from filetab. Opens a window with the pos-
sible templates, select what is suitable for you by clicking on it with the mouse.

39.2.2 Use the Size drop-down menu to select the paper size. Use the Source drop-down menu to select the printer source. Select 
the orientation of the page using the radio buttons. Use the text boxes to set the margin dimensions.

39.2.3 Use the ‘Stamp’ button on the Print Preview page to change the text on the printed views. Click on the Text tabs to select 
the text to be changed. The width and height of the text boxes can be changed by using the Width and Height text boxes. The font in 
each text box can be changed using the Font drop-down menus and radio buttons.

39.2.2

39.2.1

39.2.3



40.1 SEARCH TOOLS - CUSTOMER SEARCH
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40.1.1 Use the ‘Customer Search’ button to access the Customer Search window.

40.1.2 Type specific information in the text box.

40.1.3 Select the search method.

40.1.4 If the name is found with the entered information it will appear in the Search Results window. Click on the customer’s name 
to access the plan(s) for the customer.

40.1.5 The ‘Edit’ and ‘Delete’ buttons are used to edit or delete the customer information.

40.1.5

40.1.4

40.1.3

40.1.2



40.2 SEARCH TOOLS - DESIGN SEARCH
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40.2.1 Use the ‘Search Design’ button to access the Design Search window.

40.2.2 Type specific information in the text box.

40.2.3 Select the radio button in which the search is to be searched. Search by Order Number, Job Name, Contract #, P.O. #, Sta-
tus, Customer and Date Range. If searching by date range click the first Calendar button and set the first date then click the second 
Calendar button to set the second date. The program will bring up all designs between these dates.

40.2.4 If the name is found with the entered information it will appear in the Search Results window. Click on the customer ‘s name 
to access the plan(s) for the customer.

40.2.5 To ‘Open’, ‘Edit’ and ‘Delete’ buttons are used to open the selected design, edit or delete the customer information.

40.2.5

40.2.4

40.2.3

40.2.2



41.1 SAVING IMAGES, BACK-UP
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Saving Images

To save an image as a JPEG click the Save As Image from filetab menu and save the image into a file.

Backing Up Designs

A backup file can be made at anytime by clicking on Backup in the filetab menu. This will create a time and date stamped folder of 
the existing project.

Purge The Database

The Purge Database option allows the user to delete files from the program that have been deleted from the computer files. To 
delete the database click on the purge Database button in the File menu. This will delete any files that are not saved on the harddrive.



41.2 LICENSE TEXT AND KEYS
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41.2.1 ‘Account’ > ‘License’ from filetab contains the ProKitchen License Agreement and License Keys.

41.2.2

41.2.1



41.2 LICENSE TEXT AND KEYS
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41.2.3 Use the License Keys menu to access the Product Key (the key that comes with the program disk) and Hardware ID (the 
unique code of your computer). The Activation Key is the number that your receive from Customer Service. If the Activation key is 
needed call Customer Service at the number in the Activation Window.



41.3 THE HELP MENU
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41.3.1 The help menu is designed for a quick reference guide. To use the help menu click the help button, click on file folder con-
taining the general category and then the sub-category.

41.3.1



41.4 VIDEO TUTORIALS
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41.4.1 To view a training video for working in ProKitchen click the mouse on the icon ‘Video Tutorials’ on the top panel. This will 
open the default browser with video clips, you can find desired video clip.

41.4.1



41.5 ABOUT PROKITCHEN
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41.5.1 To see information about current ProKitchen version in filetab click ‘Help’ > ‘Index’ - Above is the version of ProKitchen, 
Installation Key, License Expiration data and a list of all the catalogs specified in your ProKitchen and their versions.

41.5.1



41.6 REPORT A PROBLEM
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41.6.1 If an error or a problem occurred you can report it by clicking on the button ‘Report a Problem’ in filetab menu. Opens a 
window in the browser where you will fill fields with data and describe the error.

41.6.1



42. NKBA GUIDELINE
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42.1 ‘NKBA Guideline’ - opens the PDF file which describes the standards of NKBA.

42.2 ‘Verify Design’ - you can check design to correspond to NKBA standards.

42.2 42.1



43.1 SHOWROOM
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ProKitchen Showroom is a free design viewer for your customers. It is enabled with the powerful Light and Shadow 3D engine and 
available on both Windows and Mac. When you complete your design you can e-mail it right from ProKitchen to your customer in 
Showroom format.

Your client can open your design in Showroom and view all details of your design in 3D the same way as if you showed it to them 
on ProKitchen. Your clients can also change the door styles, finishes and colors at their leisure and e-mail you back their selection. 
You can then complete and price it in ProKitchen.

Real View grants all the designer and dealers with the free distribution license of the ProKitchen Showroom.

E-mail your clients the ProKitchen Showroom download link. Burn and distribute ProKitchen Showroom CDs to your clients for 
FREE.



43.1 SHOWROOM
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Showroom Standard

43.1.1 The program allows browsing designs in 3D and change options and texture of walls, floors, ceilings and countertops. Make 
rendering in HD. Options are changed in the right panel. The changes appear in 3D immediately.

43.1.2 The left panel contains the following commands: Upload a design; Close the design; Save design; Save the image; Print im-
age; Rotate left/right/up/down - for rotating design; Shift left/right/up/down - for rotating design; Zoom in/out - zoom in/out design.

43.1.2

43.1.1



43.1 SHOWROOM

288 PAGE PROKITCHEN TRAINING MANUAL

Countertop Style - change the texture and color of countertops. Clicking on the icon opens a window with the available textures. 
Choose the right texture and click ‘Apply’; Floor Style - to change the texture and color of the floor. Clicking on the icon opens a win-
dow with the available textures. Choose the right texture and click ‘Apply’; Wall Style - to change the texture and color of the walls. 
Clicking on the icon opens a window with the available textures. Choose the right and click ‘Apply’; Ceiling Style - to change the tex-
ture and color of the ceiling. Clicking on the icon opens a window with the available textures. Choose the right and click ‘Apply’; Hide 
Invisible Walls - make turned to you wall invisible; Light - possible to adjust the lighting power or off unnecessary lights.



43.1 SHOWROOM
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HD - brings up a window where you can make the rendering of images by setting the desired parameters. Here you can select the 
level of gloss, haze for the floor, walls, ceiling, windows, countertops and appliances using the slider.

Use the slider to adjust the brightness and image lightning. Select Resolution. Click ‘Render’.

When the picture is generated, the icon with the floppy disk and printer will become active. The picture can be saved or printed.



43.1 SHOWROOM
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43.1.3 Showroom Light - allows browsing designs in 3D, edit lighting and render it in HD. Also save the image, print it.

Showroom Light does not give the opportunity to change the option, the texture and the color of floors, walls, countertops and 
ceiling as the Showroom Standard. The rest commands on the left panel are identical with Showroom Standard.



43.2 IPROK3D (PHONES/TABLETS)
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iProK3D for iPhone, iPad and Android devices brings fully rotational, 3D kitchen and bathroom designs right to the palm of your 
hand.

We’re proud to be the first interior design software to give our designers access to robust 3D designs through a mobile application. 
Simply complete your design in ProKitchen, then email it to your customer with a link to download the iProK3D mobile application. 
With one click, your customer can open, view, rotate and zoom in on the design.

iProK3D is Free



43.3 PROKICHEN STYLUS
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ProKitchen Stylus is a new way to design, keyboard and mouse free

ProKitchen Stylus merges the innovative technology of design technology with the tools you’re most familiar with – your own 
hands. The result is a design experience that’s both comfortable and intuitive. It’s the same software you know and love, optimized 
for your tablet device.

Use you Stylus pen to Draw, Drop, Drag and Move; To left click, tap your stylus pen once; To right click, tap your stylus pen and hold 
down.

When you need to type numbers or letters, a small, non-intrusive keypad will automatically appear! You can even generate Stand-
ard 3D and High Definition 3D renderings on your tablet.

And generate customer and manufacturer reports too!



44.PROKITCHEN ONLINE FEATURES
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ProKitchen Online is now available directly on manufacturers’ websites!

The ProKitchen Online Manufacturer Edition is easily accessible through the dealer section of theses manufacturer websites. Sim-
ply login through the dealer portal & start designing with their catalogs!

It’s easy to keep your design options open with our simple upgradeable features. Our worry-free system allows you to opt-in to a 
multi-manufacturer upgrade at any time without losing any of your previous designs and preferred settings!

Key Features:

- Full suite of ProKitchen’s professional design software, now available completely online

- Hundreds of manufacturer and appliance catalogs and thousands of 3D shapes available

- Work from any computer at any time through your internet browser

- No hardware keys, downloads or installation required

- Open, edit and save designs within the Cloud



44.PROKITCHEN ONLINE FEATURES
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- Work collaboratively on designs with other designers at the same time

- Easily manage designer accounts and licenses online

- Store all designs and customer information conveniently in one database

- Update instantly.

- Manufacturer catalog updates delivered on login via ProKitchen Instant Catalog Technology.

- Design on the go.

- Improve your designs by sharing ideas and working concurrently on projects with other designers.



44.PROKITCHEN ONLINE FEATURES
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44.1 Instant Catalog Technology (ProK-Online Only)

Manufacturer catalog updates delivered on login via ProKitchen Instant Catalog Technology.

44.2 Save/Open Design on Cloud (ProK-Online Only)

– Open, edit and save designs within the Cloud

You can save or open design from a Cloud or from your computer. Also we can open any available design from Cloud. Saved designs 
would be available from any computer in Cloud.

44.2



44.PROKITCHEN ONLINE FEATURES
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44.3 Share a design in real time (ProK-Online Only). 

Improve your designs by sharing ideas and working concurrently on projects with other designers. You can open any shared de-
sign. Also we can make our design shared for any users.

44.3



44.PROKITCHEN ONLINE FEATURES
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44.4 Access on any computer (ProK-Online Only). 

Work from any computer at any time directly on the manufacturer’s website. No hardware keys or program downloads required.

44.5 No security device is required (ProK-Online Only). ProKitchen Online is a web-based software solution that gives you com-
plete access to the entire scope of the ProKitchen Software design suite, without tying you down to a hardware key. Revolutionize the 
way you do business by transforming any computer into your personal design studio with the click of a button.

44.6 No lengthy program installs or updates (ProK-Online Only)

Prok-Online has a rapid download, it loads quickly on any computer. Installation size is much less because all resources are taken 
as required from the server.


